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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 
 

В условиях современного общества неотъемлемым качеством 
квалифицированного культуролога-менеджера становится высокий уровень 
владения компьютерными технологиями. Это предполагает знание и 
интегрированное использование всех типов программ двух- и трехмерной 
компьютерной графики, как растровой, так и векторной, умение их 
применять на всех этапах разработки продукта, а также знакомство с 
профессиональными графическими ресурсами сети Интернет в своей 
предметной области. 

Цель УМК по учебной дисциплине “Компьютерная графика”– 
обеспечить студентов базовыми  знаниями в области обработки графической 
информации с учетом текущего состояния и мировых тенденций развития 
программных и технических средств двухмерной и трехмерной графики.  

Объектом изучения дисциплины являются цифровые графические 
изображения. Предметом – методы и технологии их обработки.  

Дисциплина “Компьютерная графика” является дисциплиной по выбору 
студентов для специальности “Культурология”. Данный курс логически 
дополняет такие изученные дисциплины как “Основы информационных 
технологий” и “Информационные технологии в культуре”, в процессе 
изучения которых студенты получают начальные знания по основам 
обработки графической информации. 

Для достижения поставленной цели необходимо решение следующих 
учебных задач дисциплины: 

– формирование целостного представления о математических основах 
геометрического моделирования и компьютерной графики;  

–  обобщение знаний об использовании компьютерной графики (КГ) в 
культуре и искусстве; 

–  освоение эффективных методов и средств решения творческих задач в 
области культуры и искусства на основе использования компьютерной 
графики; 

В результате изучения дисциплины студент должен знать:  
– основные понятия и концепции геометрического моделирования и 

компьютерной графики, 
– особенности использования программных средств обработки 

графической информации в дизайне; 
– специфику работы с растровой и векторной графикой; 
– состав конфигурации персонального компьютера для обработки 

статической и динамической графики; 
– состав, функции и назначение программного обеспечения для 

обработки графической информации; 
– основные характеристики изображения; 
– характеристики цветовых пространств; 
– принципы и этапы тоновой и цветовой коррекции; 
– особенности подготовки графических изображений для сети Интернет. 
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Студент должен уметь: 
– анализировать графическое изображение; 
– обрабатывать цифровые фотографии; 
– использовать различные технологии работы в программах растровой и 

векторной графики и уметь применять их интегрировано для решения 
конкретных задач; 

– выполнять тоновую и цветовую коррекцию изображений; 
– работать с периферийным оборудованием; 
– выполнять предпечатную подготовку графических изображений; 
– работать с графическими ресурсами локальных и глобальных 

компьютерных сетей, использовать сетевые средства поиска и обмена 
графической информацией. 

Студент должен владеть: 
– техническими и программными средствами создания компьютерной 

графики; 
– методами и инструментами обработки цифровых изображений; 
– технологией ретуши изображений в зависимости от области 

применения. 
При изучении данной дисциплины предусматривается выполнение и 

реализация авторского проекта. 
Содержание УМК направлено на формирование академических 

компетенций, включающих знания и умения по изученным учебным 
дисциплинам, умение учиться, а также социальных и профессиональных 
компетенций. 
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ТЕОРЕТИЧЕСКИЙ РАЗДЕЛ 
      КОНСПЕКТ ЛЕКЦИЙ 

 
Тема 1. Теоретические основы компьютерной графики и 

геометрического моделирования 
 
Краткое содержание 
Геометрическое моделирование как основа компьютерной графики. 

Геометрическая модель.  Математическая форма представления 
геометрических элементов: явное задание, неявное задание, параметрическое 
задание, геометрическое и матричное представление.  

Сплайны. Опорные точки сплайна. Типы вершин сплайна: с изломом, 
сглаженная, Безье, Безье с изломом. Виды сплайнов: линейный, 
квадратичный, кубический,  Безье, NURBS.   

Фрактальная графика. Бенуа Мандельброт. Самоподобие. 
Классификация фракталов: геометрические, алгебраические, стохастические 
фракталы. Фрактальная живопись. 

Графические редакторы. Сравнительный анализ подходов к 
редактированию векторной и растровой графики.  

Конфигурация компьютера для работы с компьютерной графикой. 
Видеокарты. Мониторы. Графические планшеты.  

 
Основные понятия 
Геометрическое моделирование - это графическое представление 

объектов и явлений с точки зрения их геометрических свойств. 
Геометрическая модель — модель объекта либо явления отражающая 

его его геометрические свойства. 
Для описания геометрических свойств реальных объектов строятся, как 

правило, твердые тела, которые описываются точками, линиями и 
поверхностями. Точки, линии, поверхности, тела называются 
геометрическими объектами. 

 
Геометрические объекты представимы в математической форме. Точки 

— координатами в заданной системе координат. Линии и поверхности — 
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математическими формулами. Твердые тела в геометрическом 
моделировании отображаются совокупностью поверхностей. 

Непараметрическое задание кривой в трехмерном пространстве:  
x = x, y = f(x), z = g(x)  

В параметрическом виде каждая координата точки кривой представлена 
как функция одного параметра t. Значение параметра задает координатный 
вектор точки на кривой (0 ≤ t ≤ 1). Кривая задаётся системой уравнений 

 x(t), y(t), z(t), 0 ≤ t ≤ 1 . 
В большинстве случаев необходимые кривые не могут являться 

функциями либо их представление в виде функций крайне затруднительно. 
К основным преобразованиям объектов относятся перенос, поворот и 

масштабирование. 
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Представление преобразований 
геометрическое                            матричное  преобразование 

 

Переноc на Dx 
единиц вдоль оси Ox и 
Dy вдоль оси Oy 

 
Поворот на угол 

a. 
 
 
Масштабировать 

в Sx раз по оси Ox и в 
Sy  по оси Oy 

Сплайн – функция, которая вместе с несколькими производными 
непрерывна на заданном отрезке [a,b], а на каждом частичном отрезке [xi, 
xi+1] в отдельности является некоторым алгебраическим многочленом 
невысокой степени вида: 

Степенью сплайна называется максимальная из степеней ni 
составляющих его многочленов Pi

n(x).  
Виды сплайнов: линейный, квадратичный, кубический,  Безье, NURBS. 
Линейный сплайн: на каждом отрезке кривая приближается линейной 

функцией, то есть степени многочленов Pi
n(x) равны единице (ni = 1). 

 
Квадратичный сплайн: на каждом отрезке кривая приближается 

квадратичной функцией, то есть степени многочленов Pi
n(x) равны двум (ni = 

2). 
Кубический сплайн: на каждом отрезке кривая приближается  

кубической функцией, то есть степени многочленов Pi
n(x) равны трем (ni = 3). 
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Сплайн Безье представляет из себя кривую, задаваемую четырьмя 
точками: двумя конечными точками (p1 и p2) и двумя контрольными точками 
(c1 и c2). Кривая начинается в точке p1 и заканчивается в точке p2. Кривая не 
проходит через контрольные точки. Эти точки действуют на кривую как 
магниты, растягивая кривую в нужных направлениях и влияя на ее изгиб. 
Кривая начинается в точке p1 и дальше идет в направлении контрольной 
точки c1. Касательная к кривой в точке p1 проходит через точку c1. А 
касательная линия в конечной точке p2 проходит через точку c2. 

Когда количество опорных точек велико сплайн Безье имеет высокую 
степень, что является неудобным. Эту проблему решает так называемый B-
сплайн. В 1972 г. Кокс и де Бур  предложили использовать функции Nik(u), 
определяемые рекурсивно. Кривая, которая строится таким образом, 
называется В-сплайном (B-spline) и записывается в следующем виде: 

Значения ti называются узловыми. 
NURBS – это частный случай кривых Безье. Расшифровка абривиатуры: 

Non-Uniform (НеОднородные), Rational (Рациональные), B—Splines ((Би-
Сплайны). 
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Редактирование сплайна это изменение положения опорных точек, 

через которые проходит сплайновая кривая, редактирование контрольных 
точек каркаса сплайна, а также изменение направления касательных в 
граничных точках, определяющих форму сплайна. 

Типы вершин сплайна: 
С изломом (Corner) – вершина, в которой сплайн претерпевает излом. 

Участки сегментов вблизи такой вершины не имеют кривизны. 
Сглаженная (Smooth) – вершина, через которую кривая сплайна 

проводится с плавным изгибом, без излома, имея одинаковую кривизну 
сегментов при входе в вершину и выходе из нее. 

Безье (Bezier) – вершина, подобная сглаженной, но позволяющая 
управлять кривизной сегментов сплайна при входе в вершину и при выходе 
из нее. Для этого вершина снабжается касательными векторами с маркерами 
в виде квадратиков зеленого цвета на концах. У вершин типа Bezier (Безье) 
касательные векторы всегда лежат на одной прямой, а удаление маркеров от 
вершины, которой принадлежат векторы, можно изменять. Перемещение 
одного из маркеров вершины Безье всегда вызывает центрально-
симметричное перемещение второго. Перемещая маркеры касательных 
векторов вокруг вершины, можно изменять направление, под которым 
сегменты сплайна входят в вершину и выходят из нее. 

Безье с изломом (Bezier Corner) – вершина, которая, как и вершина типа 
Bezier (Безье), снабжена касательными векторами. Однако у вершин Bezier 
Corner (Безье с изломом) касательные векторы не связаны друг с другом, и 
маркеры можно перемещать независимо. 
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Фрактальная графика — вид компьютерной графики в математической 

основе которой лежит  фрактальная геометрия. 
 — геометрическая фигура, обладающая свойством 

самоподобия, то есть составленная из нескольких частей, каждая из которых 
подобна всей фигуре целиком  

Объект называют самоподобным, когда увеличенные части объекта 
походят на сам объект и друг на друга. В простейшем случае небольшая 
часть фрактала содержит информацию обо всем фрактале.  

Термин «фрактал» введён Бенуа Мандельбротом в 1975 году и получил 
широкую известность с выходом в 1977 году его книги «Фрактальная 
геометрия природы».  

Геометрические фракталы. Фракталы этого типа строятся поэтапно. 
Сначала изображается основа. Затем некоторые части основы заменяются на 
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фрагмент. На каждом следующем этапе части уже построенной фигуры, 
аналогичные замененным частям основы, вновь заменяются на фрагмент, 
взятый в подходящем масштабе. Всякий раз масштаб уменьшается. Когда 
изменения становятся визуально незаметными, считают, что построенная 
фигура хорошо приближает фрактал и дает представление о его форме. Для 
получения самого фрактала нужно бесконечное число этапов. Меняя основу 
и фрагмент, можно получить много разных геометрических фракталов. К 
таким фракталам относятся Снежинка Коха, Дерево Пифагора, Треугольник 
Серпенского и другие. 

Динамические (алгебраические) фракталы. Фракталы этого типа 
возникают при исследовании нелинейных динамических систем. Поведение 
такой системы можно описать комплексной нелинейной функцией 
(многочленом) w = f(z), где z и w – комплексные числа: z = ai + b, w= ci + d, 
где a, b, c, d – действительные числа, i – мнимая единица, такая что i2=-1. 
Возьмем какую-нибудь начальную точку z0 на комплексной плоскости. 
Теперь рассмотрим бесконечную последовательность чисел на комплексной 
плоскости, каждое следующее из которых получается из предыдущего:  

z0, z1 = f(z0), z2 = f(z1), ... zn+1 = f(zn).  
В зависимости от начальной точки z0  и функции такая 

последовательность может вести себя по-разному: стремиться к 
бесконечности при n → ∞; сходиться к какой-то конечной точке; циклически 
принимать ряд фиксированных значений; возможны и более сложные 
варианты. 

Множество Мандельброта.  Рассмотрим функцию fc(z) = z2 + с, где c — 
комплексное число. Построим последовательность этой функции с z0 = 0, в 
зависимости от параметра с она может расходиться к бесконечности или 
оставаться ограниченной. При этом все значения с, при которых эта 
последовательность ограничена, как раз и образуют множество 
Мандельброта. Оно было детально изучено самим Мандельбротом и другими 
математиками, которые открыли немало интересных свойств этого 
множества. 
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Еще одним известным классом фракталов являются стохастические 
фракталы, которые получаются в том случае, если в итерационном процессе 
случайным образом менять какие-либо его параметры. При этом получаются 
объекты очень похожие на природные – несимметричные деревья, 
изрезанные береговые линии и т.д. Двумерные стохастические фракталы 
используются при моделировании рельефа местности и поверхности моря. 

Фрактальное искусство – это одно из направлений цифрового 
искусства, объекты которого строятся при помощи реализации алгоритмов 
фрактальной геометрии с помощью программного обеспечения 

 
Тема 2. Цифровое искусство  

 
Краткое содержание 
Понятие цифрового искусства. История КГ. Направления КГ: 3D 

моделирование и визуализация, цифровой коллаж, цифровая живопись, 
фрактальная графика, компьютерная анимация. Синергетичные направления 
цифрового искусства: демосцена, компьютерный перформанс, 3D мэпинг. 

КГ как инструментарий традиционных видов искусств (архитектуры и 
скульптуры, кино и мультипликации, музыки, театра и др.).  

Электронная фиксация произведений искусства: особенности и 
технологии. Изображения с высоким динамическим диапазоном (HDRI). 
Форматы HDRI.  

Цифровая иллюстрация. История и виды цифровой иллюстрации. Сферы 
применения и специфика цифровой иллюстрации.  

 
Основные понятия 
Компьютерное искусство (цифровое искусство, дигитальное искусство) 

— творческая деятельность, основанная на использовании информационных 
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(компьютерных) технологий, результатом которой являются художественные 
произведения в цифровой форме.На данный момент понятие «компьютерное 
искусство» включает в себя как произведения традиционного искусства, 
перенесённые в новую среду, на цифровую основу, имитирующую 
первоначальный материальный носитель (когда, например, за основу берется 
отсканированная или цифровая фотография), или созданные изначально с 
применением компьютера, так и принципиально новые виды 
художественных произведений, основной средой существования которых 
является компьютерная среда. 

 — создание электронных изображений, 
осуществляемое не путём рендеринга компьютерных моделей, а за счёт 
использования человеком компьютерных имитаций традиционных 
инструментов художника. 

Синергетичные направления цифрового искусства: демосцена, 
компьютерный перформанс, 3D мэпинг. 

Демосцена — это субкультура и направление компьютерного искусства, 
главной особенностью которого является выстраивание сюжетного 
видеоряда, создаваемого в реальном времени компьютером, по принципу 
работы компьютерных игр. Таким образом, демо является симбиозом 
программирования и искусства. Демосцена — киберкультура, существующая 
в Юзнете, Фидонете и Интернете. 

Маппинг – это способ нанесения виртуального изображения на реальный 
объект.  

Плоский маппинг 
Проекция плоской картинки на объекты при расстановке проекторов в 

специальные проекционные точки для обеспечения разных ракурсов и 
создания иллюзии объема. Чтобы создать реалистичное объемное 
изображение используют медиасервер. 

Медиасервер необходим для компенсации геометрического искажения 
от каждого проектора. Он максимально точно накладывает проекции одна на 
другую. Таким образом, плоский маппинг – это наиболее простой способ 
изобразить псевдотрехмерную графику на объемных предметах. Основное 
отличие от одиночной проекции в том, что в плоском маппинге затенение 
объектов друг другом мы сводим к минимуму. Однако, наблюдатели 
остаются привязаны к центральной точке обзора. 

Плоский маппинг подходит для архитектурной проекции, в случае, если 
зрители находятся вдалеке от здания, и никто не смотрит сбоку. Плоский 
маппинг не подходит для демонстрации внутри помещения. 

3D мэпинг позволяет с каждым 3D объектом работать индивидуально. 
Для каждой части объекта (окна здания, двери здания, колоны здания и т.д.) 
моделируется отдельный сценарий. Качество изображения при этом не 
зависит от угла обзора. 

Перфоманнс (англ. performance — выступление, исполнение, игра, 
представление) — форма современного искусства, одна из разновидностей 
акционизма, входящего в концептуализм 1960-х годов. Перформанс — 
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короткое представление, исполненное одним или несколькими участниками 
перед публикой художественной галереи или музея. Перморманс в отличие 
от живописи не требует специальной подготовки для адекватного 
восприятия, даже наоборот, он предполагает отказ от привычных ожиданий и 
подходов к нему как произведению искусства. Перформанс в наиболее 
обостренной форме демонстрирует ориентацию концептуализма на сознание, 
не замутненное идеологией и стереотипами. Как правило, концептуальный 
перформанс работает с чисто абстрактными категориями: временем, 
пространством, человеческим телом в пространстве, позицией созерцания, 
расстоянием, длительностью и т. д. Перформанс условно можно назвать 
театром визуальных искусств, поскольку в него включаются элементы 
пантомимы, танца, музыки, поэзии, видео, кино. 

Интерактивный компьютерный перфоманс – это вид искусства, 
который позволяет зрителю (пользователю) практически наравне с автором 
участвовать в создании художественного произведения. Это не замкнутое 
пространство, которое можно только наблюдать, а среда, допускающая 
активное вмешательство. Перфоманс представляет собой определенный 
набор образов, звуков, слов; это художественный мир в компью- терной сети, 
где пользователю можно участвовать в его создании, изменении. Вовлече- 
ние пользователя в общение с произведением уменьшает роль художника и 
снимает с него часть ответственности; произведение становится до 
бесконечности подвижным, бывший зритель получает возможность 
«творить».  

Динамический диапазон - это мера спектра освещения на различных 
уровнях - от темных, черных оттенков до самых ярких, белых, которая  
определяет количество контраста, которое может быть зафиксировано или 
отображено без потери деталей. 

HDR (High Dynamic Range) — с английского переводится, как высокий 
динамический диапазон, позволяющий получать изображения с высоким 
динамическим диапазоном. При создании изображения используется 
информация из нескольких снимков, сделанных с разной экспозицией, на 
которых отчетливо видны детали и светлых, и темных частей снимка.  

Для создания HDR - изображения делается как минимум три кадра: на 
одном весь динамический диапазон отдается под свет, на другом — под тени 
и на третьем берется средний диапазон. HDR — это изображение, в котором 
все диапазоны объединены. При таком способе создания изображения для 
отображения теней будет 12 бит градаций яркости, по столько же на светлых 
участках и в середине. Итого, 36 разных уровней яркости. 

Цифровая иллюстрация — создание электронных изображений с 
помощью компьютерных имитаций традиционных инструментов художника. 
Компьютер предоставляет высокотехнологичные функции инструментов и 
возможностей, таких, как создание слоев и текстур; генерация шумов 
заданного типа; различные эффекты кистей; HDR картины; многообразие 
фильтров и возможностей коррекции; скорость работы и возможность 
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вносить исправления на любом этапе, возможность остановить, сохранить и 
возобновить работу в любой момент, и многое другое. 

 
Тема 3. Трехмерное моделирование 

 
Краткое содержание 
Геометрическое моделирование как основа трехмерной графики. Классы 

геометрических моделей. Особенности и возможности полигонального и 
NURBS-моделирования. Основные подходы к геометрическому 
моделированию: конструктивная геометрия, граничное представление.   

Системы координат: декартова, мировая, экранная, видовая, локальная, 
родительская. Способы проецирования. Проекции: ортогональные, 
аксонометрические. Афинные преобразования. 

Программные средства трехмерного моделирования. Сферы 
применения. Система моделирования и анимации 3D Studio Max. Элементы 
интерфейса 3DSMax. Классы объектов. Этапы создания геометрической 
модели сцены. Способы создания и изменения объектов. Особенности 
создания трехмерных объектов для компьютерных игр. 

Понятие текстурирования. Цвет объектов в трехмерной сцене. Создание 
и определение свойств материалов. Источники света и камеры. Способы 
создания анимации. Понятие визуализации (рендеринга). Типы рендеров. 
Методы рендеринга.  

3D слои в двумерной графике. Приемы трехмерного моделирования в 
двумерной графике.  

Конфигурация компьютера для работы с трехмерной графикой. 
Интерфейс прикладного программирования (API). API графических 
интерфейсов OpenGL, Direct3D. Настройка API. 3D сканеры. 

 
Основные понятия 
Геометрическое моделирование подразделяется на каркасное, 

поверхностное, моделирование твердых тел.  

 
Каркасные модели (Wire-frame Geometry) характеризует форму тела 

набором пространственных линий. Элементарные геометрические объекты - 
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вершины (точки) и ребра (линии). Каркасное представление часто 
используется как один из экономных методов визуализации, но его главный 
недостаток — неоднозначность. 

 

 
Модели поверхностей (Surface Geometry) характеризует форму тела 

набором ориентированных поверхностей, ограничивающих его. 
Элементарные геометрические объекты - вершины, ребра и грани тела, 
заданные координатами точек и уравнениями линий и поверхностей. Базовые 
операции - продление, обрезка, соединение поверхностей. Такое 
представление удобно для задач программирования, однако может приводить 
к неоднозначностям при моделировании сложных объектов.  

Модели конструктивной твердотельной геометрии (CSG - Constructive 
Solid Geometry) формируется как композиция некоторых областей 
пространства с помощью теоретико-множественных операций. 
Элементарные геометрические объекты (примитивы) - простые тела (сфера, 
конус, цилиндр и др.). Базовые операции - объединение, пересечение, 
отсечение. Структура модели - дерево (вершины - примитивы, ребра - 
операции).   
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Твердотельные модели граничного представления (B-Rep - Boundary 
Representation) описывает множество граничных точек как совокупность 
вершин, ребер и граней. Примитивы и базовые операции - те же, что и для 
CSG, различия состоят лишь в способах хранения модели в памяти.  

Поверхностные модели различаются по способу аппроксимации 
поверхности. Более простой в части структуры данных и используемых для 
работы с ними алгоритмов является полигональная аппроксимация, когда 
поверхность представляется набором взаимосвязанных плоских граней, на 
практике чаще всего треугольных. Такая аппроксимация легко строится, для 
нее разработаны эффективные алгоритмы реалистичной  визуализации,  она  
не  требует  значительных вычислительных ресурсов, хотя может быть и 
затратной по памяти. Главным ограничением такой аппроксимации является 
то, что она имеет фиксированную точность, т.е. отклонение положения 
модельной поверхности от «идеальной» моделируемой. Для достижения 
высокой точности требуется создание сеток с малым шагом, что ведет к 
росту требований к вычислительным возможностям системы. Поэтому 
использование полигональной аппроксимации на текущий момент 
ограничено подсистемами визуализации и простейшего 3D эскизирования. 

Этих недостатков лишена технология NURBS ( Non-Uniform Rational B-
Spline , неоднородный B-сплайн), сегодня наиболее часто используемая в 
практике. Такое описание поверхности обеспечивает определение координат 
любой ее точки, радиуса кривизны в ней, направления нормали к 
поверхности с высокой, в общем случае (без учета вычислительных затрат) с 
любой наперед заданной точностью. Определенным недостатком такого 
подхода является сложность алгоритмов работы с NURBS, однако это  
обстоятельство  исторически преодолено исследователями и разработчиками. 

В определенной степени, NURBS-представление является развитием 
полигонального, но в отличие от него позволяет описывать не только 
плоские, но и криволинейные грани и ребра (кромки). Совокупность таких 
граней общими ребрами по традиции называют сеткой. Технология NURBS 
обеспечивает реализацию ряда функциональных возможностей, недоступных 
или существенно ограниченных при использовании каркасного или  
полигонального представления: вычисление радиуса кривизны поверхностей, 
их гладкое сопряжение, построение траекторий на поверхности, получение 
точных изображений спроецированных на плоскость, например для 
получения чертежных видов и т.д.  
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Традиционно в системах автоматического проектирования (САПР) 
используется несколько типовых контекстов создания поверхностей: 

• плоская поверхность — получается заполнением плоского контура 
(2D-эскиз или набор замкнутых кромок, лежащих в одной плоскости); 

• поверхность вытяжки — образуется в результате плоскопараллельного 
вытягивания замкнутого или разомкнутого 2D/3D-эскиза в направлении, 
перпендикулярном плоскости эскиза, или под произвольным углом; 

• поверхность вращения — получается вращением произвольного 
профиля (2D-эскиз) относительно оси; 

• поверхность по траектории — создается движением 2D/3D-эскиза 
вдоль криволинейной образующей (2D/3D-эскиз, 3D-кривая) и 
произвольного числа направляющих кривых (2D/3D-эскиз, 3D-кривая), 
деформирующих исходный контур; 

• поверхность по сечениям — аналог поверхности по траектории; 
отличается тем, что строится не по одному, а по нескольким поперечным 
сечениям с направляющими кривыми; 

• граничная поверхность — аналог поверхности по сечениям; отличается 
тем, что строится по нескольким произвольно сориентированным в  
пространстве 3D-кромкам других поверхностей с сохранением касательности 
к ним и с соблюдением непрерывности по второй производной (гладкая 
стыковка); при построении могут использоваться направляющие кривые; 

• поверхность свободной формы — строится разбиением сетки с 
управляющими точками на поверхности грани 3D-модели; изменение формы 
поверхности достигается перетаскиванием контрольных точек; 

• эквидистантная поверхность — получается смещением на 
определенное расстояние от существующих граней или поверхностей; 

• поверхность разъема — используется при проектировании литейных 
форм в качестве вспомогательной геометрии для разделения матрицы и 
пуансона; 

• рединная поверхность — создается на середине (или заданном 
проценте) толщины тонкостенной детали; 
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• линейчатая поверхность — строится под углом к выбранной кромке и 
предназначена для построения граней с уклоном; 

В том случае, если установлена программная связь между 
вспомогательным каркасом и результирующей поверхностью – 
моделирование становится ассоциативным, при этом изменение каркасных 
элементов ведет к автоматическому изменению геометрии поверхностей, 
поостренных с использованием этого контекста. 

 
Несмотря на достаточно широкие возможности, которые предоставляет 

поверхностное моделирование, и оно имеет ряд существенных ограничений с 
точки зрения использования в САПР, в частности невозможность 
вычисления объемов, масс и моментов инерции объектов, ограниченность 
применения к ним булевых операций (вычитания, объединения, 
пересечения). Эти ограничения снимаются при использовании 
твердотельного моделирования, ставшего на сегодня стандартом де-факто в 
3D CAD/CAM/CAE системах. Существуют различные алгоритмические 
методы представления твердотельных моделей – воксельное, использование 
октарных и бинарных деревьев, однако в практике САПР наиболее широкое  
применение имеет  технология,  базирующаяся  на  граничном  
представлении элементарных односвязных тел (BREP, Boundary 
Representation) в совокупности с конструктивной геометрией (CSG, 
constructive solid geometry) описывающей операции над телами. 

Граничное представление определяет сплошное тело неявно путем 
описания ограничивающей его поверхности. Суть BREP-представления 
заключается в том, что твердое тело описывается замкнутая 
пространственная область, ограниченная набором элементарных тонких 
поверхностей (граней), с общими образующими контурами (ребрами) на 
границе поверхностей и признаком внешней или внутренней стороны 
поверхности, а также обеспечивающим следующий ряд операций, 
определенных над телами: 

• проверка правильности задания, для односвязных тел осуществляется 
по формуле Эйлера, в наиболее общем виде записываемой как: 
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V - E + F = 2, 
где, V - количество вершин, E - количество ребер, F - количество граней; 
• вычисление габаритного объема; 
• вычисление кривизны поверхности; 
• нахождение точки пересечения с контуром или другой поверхностью; 
• определение положения точки относительно поверхности. 

Для описания сложных тел, моделирующих объекты реального мира, 
получаемые обработкой материала или неразъемной сборкой, используется 
иерархическая структура, описывающая тела как последовательность 
применения булевых операций над набором элементарных твердых тел - так 
называемое CSG-дерево (Constructive Solid Geometry tree). В рамках CSG 
представления для описания составных твердых тел определены следующие 
операции над исходными  элементарными телами (а): вычитание (б);  
объединение (в); пересечение (г). 

Также как и для элементарного тела, правильность построения 
определяется формулой Эйлера, записываемой для многосвязных тел в 
частном виде: 

V - E + F - H = 2(C - G) 
где, V - количество вершин, E - количество ребер, F - количество граней, 

H — количество несквозных отверстий, C - количество компонент, G - 
количество сквозных отверстий. 
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Таким образом, любое составное тело может быть описано в виде 
традиционного уравнения из булевых функций, в котором аргументами 
являются либо элементарные тела, либо другие составные тела. Это 
представление называют деревом построений. Такое представление, кроме 
удобства модификации геометрии результирующего тела, позволяет 
существенно снизить требования к вычислительным ресурсам за счет 
применения оптимизирующих процедур к дереву построений. 

 
 
Представление твердых тел в виде дерева построений удобно также и с 

точки зрения организации пользовательского интерфейса, обеспечивающего 
наглядный и быстрый доступ к любому элементу, входящему в описание 
геометрии тела, его модификацию и получение отчетной информации. 
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Системы координат – это совокупность правил, ставящих в 
соответствие каждому объекту (точке) набор чисел (координат)  

(x1, y1), (x1, y1, z1), (x3, y3).  
Число координат, требуемое для определения точки, определяет 

размерность пространства.  

 
Декартовыми прямоугольными координатами точки P в двумерном 

пространстве называются взятые с определенным знаком расстояния 
(выраженные в единицах масштаба) этой точки до двух взаимно 
перпендикулярных координатных осей или, что то же самое, проекции 
радиус-вектора r точки P на две взаимно перпендикулярные координатные 
оси. 

Полярными координатами точки P называются радиус-вектор ρ - 
расстояние от точки P до заданной точки O (полюса) и полярный угол φ - 
угол между прямой OP и заданной прямой, проходящей через полюс 
(полярной осью). Полярный угол считается положительным при отсчете от 
полярной оси против часовой стрелки и отрицательным при отсчете в 
обратную сторону. Координатные линии в полярных системах - окружности 
с центром в полюсе и лучи 

Формулы для перехода от полярных координат к декартовым: 
x=ρ*cos(φ), y=ρ*sin(φ). 

В литературе по компьютерной графике используют также (в 
зависимости от способа представления графических данных) следующие 
разновидности координатных систем: локальные, глобальные, мировые, 
приборные и другие. 
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Локальная система координат – дву-или трехмерная система 
собственных координат объекта. В ней производится моделирование 
объекта. В частных случаях локальная система координат может быть 
декартовой, аффинной, полярной и т.д. 

Глобальная система координат – дву- или трехмерная система 
координат, в которой описывается взаимосвязь между объектами, например, 
их взаимное расположение. В частных случаях система может быть 
декартовой, аффинной, полярной и т. д. 

Мировая система координат – дву- или трехмерная система координат, 
которая является входной системой координат базисных графических систем. 
Она используется для описания изображений. 

B 3ds Max включена видовая система координат View (Видовая). Она 
характеризуется тем, что во всех окнах проекций, кроме перспективного, 
используется система координат экрана Screen - экранная, в которой 
направление осей зависит от выбранного видового окна. Глобальная система 
координат (World) или мировая является единой системой координат для 
всех объектов сцены. Bсе трехмерные объекты перемещаются по оси Х – 
горизонтально (справа налево и слева направо); по оси Y – к наблюдателю и 
от наблюдателя; по оси Z – вертикально (вверх и вниз). Глобальная система 
координат используется в окне проекции Perspective (Перспективный вид). 

Экранная система координат (Screen) используется в ортогональных 
видах, то есть в окнах проекций Тор (Вид сверху), Front (Вид спереди) и Left 
(Вид слева). В этих окнах проекций трехмерные тела спроецированы на 
заданную плоскость в виде двухмерных. Согласно системе координат Screen 
(Экранная), оси всегда одинаково повернуты в любом видовом окне: X – 
вправо,Y– вверх, а Z направлена от наблюдателя, то есть проецируется в 
точку. 

Видовая система координат (View) сочетает в себе две предыдущие 
системы. 

 
Проецирование - это процесс получения изображения предмета на 

какой-либо поверхности Получившиеся при этом изображение называют 
проекцией предмета. 
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Элементами, с помощью которых осуществляется проецирование, 
являются: центр проецирования - точка, из которой производится 
проецирование; объект проецирования - изображаемый предмет; плоскость 
проекции - плоскость, на которую производится проецирование; 
проецирующие лучи - воображаемые прямые, с помощью которых 
производится проецирование, результатом проецирования является 
изображение, или проекция, объекта. 

 

 
Различают центральное и параллельное проецирование. При 

центральном проецировании все проецирующие лучи исходят из одной точки 
- центра проецирования, находящегося на определённом расстоянии от 
плоскости проекций. На рисунке «Центральное проецирование» за центр 
проецирования условно взята электрическая лампочка. Исходящие от неё 
световые лучи, которые условно приняты за проецирующие, образуют на 
полу тень, аналогичную центральной проекции предмета. Метод 
центрального проецирования используется при построении перспективы. 
Перспектива даёт возможность изображать предметы такими, какими они 
представляются нам в природе при рассмотрении их с определённой точки 
наблюдения. 

При параллельном проецировании все проецирующие лучи параллельны 
между собой. Центр проецирования предполагается условно удалённым в 
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бесконечность. Тогда параллельные лучи отбросят на плоскость проекций 
тень, которую можно принять за параллельную проекцию изображаемого 
предмета. В черчении пользуются параллельными проекциями. Выполнять 
их проще, чем центральные. Если проецирующие лучи составляют с 
плоскостью проекций примой угол, то такие параллельные проекции 
называются прямоугольными. Прямоугольные проекции называют также 
ортогональными.  Чертежи в системе прямоугольных проекций дают 
достаточно полные сведения о форме и размерах предмета, так как предмет 
изображается с нескольких сторон.  

Аксонометрические проекции передают одним изображением 
пространственную форму предмета. Такое изображение создаёт у человека 
впечатление, близкое к тому, которое получается при рассмотрении предмета 
в "натуре". Аксонометрические проекции получаются, если изображаемый 
предмет вместе с осями координат, к которым он отнесён, с помощью 
параллельных лучей проецируют на одну плоскость, называемой 
аксонометрической. 

Слово "аксонометрия" переводится "измерение по осям или измерения 
параллельно осям", так как размеры изображаемого предмета откладываются 
параллельно осям х, у, z называемым аксонометрическими осями. В 
зависимости от наклона осей координат х, у, z к аксонометрической 
плоскости и угла, составляемого проецирующими лучами с этой плоскостью, 
образуются различные аксонометрические проекции. Если проецирующие 
лучи перпендикулярны плоскости, то проекция называется прямоугольной. 
Если проецирующие углы наклонны к плоскости, то проекция называется 
косоугольной. 

 (от лат. affinis — соприкасающийся, близкий, 
смежный) — отображение плоскости или пространства в себя, при котором 
параллельные прямые переходят в параллельные прямые, пересекающиеся в 
пересекающиеся, скрещивающиеся в скрещивающиеся.К аффинным 
преобразованиям относятся движения. Движения — это такие 
преобразования, которые сохраняют расстояние между любыми двумя 
точками неизменным, а именно параллельные переносы, повороты, 
различные симметрии и их комбинации. Другой важный случай аффинных 
преобразований — это растяжения и сжатия относительно прямой. 
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Редакторы трехмерной графики: 
- 3D-Studio Max; 
- Autodesk Maya (от Санскритского слова māyā, майа, которое означает 

иллюзия). С её помощью были реализованы такие кино- и анимационные 
персонажи, как Стюарт Литтл, Человек-невидимка, Шрэк, ВАЛЛ-И,Голлум 
(Властелин колец), Халк, Дейви Джонс (Пираты Карибского моря); 

-Blender - Многоплатформенный графический 3D пакет, 
распространяемый с открытым исходным кодом; 

- Google SketchUp – создание, редактирование и публицация 3D-моделей  
домов, мебели и интерьера; 

Sweet Home 3D - создание дизайна интерьера и др. 
 
3D-сканер — периферийное устройство, анализирующее физический 

объект и на основе полученных данных создающее его 3D-модель. 3D-
сканеры делятся на два типа по методу сканирования: контактный и 
бесконтактный.  

Контактный метод основывается на непосредственном контакте сканера 
с исследуемым объектом. Бесконтактные сканеры в свою очередь делятся на 
активные и пассивные. Активные сканеры излучают на объект некоторые 
направленные волны (чаще всего свет, луч лазера) и обнаруживают его 
отражение для анализа. Возможные типы используемого излучения 
включают свет, ультразвук или рентгеновские лучи. Пассивные сканеры не 
излучают ничего на объект, а вместо этого полагаются на обнаружение 
отраженного окружающего излучения. Большинство сканеров такого типа 
обнаруживает видимый свет — легкодоступное окружающее излучение. 

Полученные методом сканирования 3D-модели в дальнейшем могут 
быть обработаны средствами САПР и, а так же для разработки технологии 
изготовления и инженерных расчётов. Для вывода 3D-моделей могут 
использоваться такие средства, как 3D-монитор, 3D-принтер или фрезерный 
станок с поддержкой G-кода. 
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Тема 4. Компьютерная графика в кинопроизводстве 
 
Кратное содержание 
Понятие CGI (англ. computer-generated imagery, «изображение, 

сгенерированные компьютером»). Дигитальный спецэффект: понятие, его 
роль и функции в современном кинематографе. История применения КГ и 
спецэффектов в кино и мультипликации. Персоналии.  

Технологии CGI. Хромакей («цветовой ключ»). Захват движения и 
мимики (motion capture, mocap). Морфинг. 3D камера. Система виртуальной 
съёмки. Визуальные эффекты. Облачная система цифрового управления 
киноактивами. 

Алгоритм создания компьютерного спецэффекта. Эффекты стихий и 
катастроф. Создание CGI-персонажей, объектов. Построение компьютерных 
пейзажей, декораций. Компоузинг (комбинирование, совмещение) 

 
Основные понятия 
CGI (англ. computer-generated imagery, букв. «изображения, 

сгенерированные компьютером») — неподвижные и движущиеся 
изображения, сгенерированные при помощи трёхмерной компьютерной 
графики и использующиеся в изобразительном искусстве, печати, 
кинематографических спецэффектах, на телевидении и в симуляторах.  

В компьютерных играх обычно используется компьютерная графика в 
реальном времени, но периодически добавляются и внутриигровые видео, 
основанные на CGI. 

Созданием движущихся изображений занимается компьютерная 
анимация, представляющая собой более узкую область графики CGI, 
применимую, в том числе в кинематографе, где позволяет создавать 
эффекты, которые невозможно получить при помощи традиционного грима и 
аниматроники. Компьютерная анимация может заменить работу каскадёров и 
статистов, а также декорации. 

Хромакей - это технология совмещения двух или больше слоев видео в 
одном кадре. Объект съемки помещается на однотонный фон с последующим 
его удалением. Чаще всего используются зеленый и синий фоны 
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Захват движения (MoCap; Motion capture) — технология для записи 
движений актеров, которые затем используются в компьютерной графике. 
Поскольку тело человека (и животных) устроено достаточно сложно, то 
гораздо проще, убедительней, а зачастую и дешевле записывать движения 
актеров и перекладывать их на трехмерные модели, чем анимировать 
трехмерные модели вручную. Большинство систем захвата движения 
работают с маркерами или датчиками, которые крепятся на тело актера, как 
правило — при помощи костюма.  

Морфинг (англ. morphing, трансформация) — технология в 
компьютерной анимации, визуальный эффект, создающий впечатление 
плавной трансформации одного объекта в другой. Используется в игровом и 
телевизионном кино, в телевизионной рекламе. Встречается в трёхмерной и 
двухмерной (как растровой, так и векторной) графике. 

Компоузинг (composing  англ.) — это электронный спецэффект, 
заменяющий комбинированные киносъемки; позволяет создать видимость 
непрерывности переходов, лишенных «швов», «заморозить» движение, 
превратить двухмерный объект в трехмерный, показать в кадре след от 
предыдущего кадра, создать и анимировать тени и т.д. Компоузинг создает 
фантазматические иллюзии дематериализации объектов, раздвоения их 
абрисов, утраты непрозрачности, проницаемости, взаимовложенности 
вещного мира, феноменов левитации и т. п. 

Комбинированная съёмка , 
(англ. compositing) — разновидность спецэффектов в кинематографе и на 
телевидении, основанных на совмещении двух и более различных 
изображений, созданных независимо друг от друга. Первые технологии 
композитинга, такие как «блуждающая маска», рирпроекция и 
фронтпроекция, предусматривали многократную экспозицию киноплёнки 
или оптическое совмещение разных изображений. Современные цифровые 
технологии кинопроизводства опираются на создание готовых изображений 
в компьютере по технике «хромакей» или средствами CGI-графики. Широко 
применяется в современной компьютерной технологии создания визуальных 
эффектов в кино, на телевизионном производстве, в рекламе, когда 
необходимо идеально симулировать сцены, не существующие в 
действительности. 
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Спецэффекты можно разделить на четыре основных группы: 
механические, оптические, дигитальные (компьютерные) спецэффекты и 
грим. Чаще всего в работе над кинокартиной используется их сочетание.  

Механические спецэффекты - взрывы, порывы ветра, дождь, снег, туман  
В эру компьютеров, оказалось, что многие эффекты грима и 

механические эффеты проще смоделировать на компьютере.  
История применения КГ.  
Первым фильмом с наличием дигитальных спецэффектов стал триллер 

«Трон» (1982) про человека, попавшего внутрь гигантского электронного 
компьютера. Графика с современной точки зрения примитивная, но иного от 
первого фильма ждать не приходилось. В фильме  «Молодой Шерлок Холмс» 
(1985, спецэффекты – Кит Уэст, Деннис Мурен)создан первый объемный 
персонаж, целиком исполненный на компьютере – рыцарь из стекляной 
мозаики в церкви, который вступает в настоящую рукопашную схватку с 
живым актером. Его получили путем сканирования рисунка и последующей 
компьютерной обработки. Работа над короткой сценой заняла четыре месяца.  

«Кто подставил кролика Роджера?» (1988, спецэффекты – Кен Рэлстон, 
Майкл Лантьери). Компьютерные технологии позволили совместить в кадре 
рисованные и живые персонажи таким образом, что их взаимодействие 
кажется совершенно естественным.  

«Уиллоу» (1988, спецэффекты – Деннис Мурен, Фил Типпетт). Первое 
использование морфинга в кино: превращение колдуньи из оппоссума в 
козла, из козла в страуса, из страуса в черепаху, из черепахи в тигра, из тигра 
в человека. Компьютер позволил показать постепенную трансформацию 
облика одного существа и превращение его в другое с помощью программы 
изменения линий тела с фотографий различных животных.  

«Бездна» (1989; спецэффекты – Деннис Марен, Хойт Йетмэн, Деннис 
Скотэк, Джон Брано). Создание специальной компьютерной программы для 
последующего воплощения на экране фантастического существа – в данном 
случае «псевдопода», состоящего из морской воды. Группа специалистов 
сначала провела длительные и полновесные исследования всех 
характеристик воды, от способности преломлять свет до процесса появления 
волн, а затем заложила эти данные в компьютер. 

«Терминатор – 2» (1991, спецэффекты – Дэннис Мурен, Роберт Скотэк). 
Развитие морфинга привело к появлению персонажа из «жидкого металла», 
который может принимать любые формы. Для этого дизайнеры создали 
компьютерную модель актера Роберта Патрика, на которую можно было 
«приклеить» любые изображения, от актрисы Линды Гамильтон до 
клетчатого пола. 

«Парк юрского периода» (1993, спец-эффекты – Деннис Мурен, Стэн 
Уинстон, Фил Типпет, Майкл Лантьери). Новая ступень в эволюции 
дигитальных спецэффектов: создание абсолютно убедительного 
компьютерного существа – динозавра, который взаимодействует с живыми 
актерами и словно бы заснят в натуре. Созданные для фильма модели были 
просканированы лазером, чтобы компьютерный образ на все 100% 
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соответствовал куклам. В картине около 6 минут чистого времени 
компьютерной графики. 

«Ворон»(1994). После трагического случая на съемках, когда актер 
Брэндон Ли погиб от огнестрельного оружия, которое по небрежности 
пиротехника было неправильно подготовлено к работе, продюсеры пришли к 
решению заменить его дублером. А там, где без облика не обойтись – 
воссоздать лицо Брэндона компьютерным способом. «Форрест Гамп» (1994, 
спецэффекты – Кен Ролстон, Джордж Мерфи, Стивен Розенбаум, Аллен 
Холл). Актер Том Хэнкс мастерски вмонтирован в старую кинохронику 
исторических событий. Нечто подобное было сделано для фильма Вуди 
Аллена «Зелиг» (1983), но только теперь на помощь режиссеру пришел 
компьютер и выполнил всю наиболее трудоемкую часть работы по созданию 
комбинированных съемок.  

«История игрушек» (1995). Первый полнометражный фильм, полностью 
нарисованный на компьютере. 

«Матрица» (1999, спецэффекты – Джон Гаэта). Новый спецэффект под 
названием «плавающая раскадровка», который до того был использован 
только в телерекламе. Объемное зависание персонажа в кадре – зритель 
видит не просто стоп-кадр или замедленную съемку, а объезд камеры вокруг 
замершего в воздухе актера! – было достигнуто путем сочетания 
компьютерных и механических средств. Съемочную площадку окружили 120 
кинокамерами, которые безостановочно передвигались по кругу, 
запечатлевая обычную актерскую игру. Потом из каждой пленки брали по 
кадру, но так, чтобы они были сделаны с разных точек. Сложив все вместе, 
получали цепочку стоп-кадров, снятых с разных углов. Пропуская через 
компьютер, добивались эффекта движения одной камеры вокруг висящего в 
воздухе человека! Все гениальное просто!  

«Звездные войны, эпизод 1: Призрачная угроза» (1999, спецэффекты – 
Питер Хатчинсон). Среди 60 дигитально синтезированных фантастических 
существ, четыре персонажа уже отпускают реплики, а пятый превращается в 
полноценного героя фильма, который на равных взаимодействует с живыми 
актерами, отличается пугливостью и даже паникерством, причем вся гамма 
чувств написана на его лице, обладающим выразительной мимикой. 

«Невидимка» (2000, спецэффекты – Ллойд Бернберг, Брайан Дэвис, 
Блондел Эйду, Скотт Андерсон). Эффект поэтапного исчезновения человека 
(начиная с кожного покрова, последовательно исчезает жировая прокладка, 
мыщцы, внутренности, кости скелета), а также движения «невидимки» под 
струями воды. 

Подобное стало реальным после завершения создания компьютерной 
программы имитации человеческого тела, когда компьютер научился не 
просто обозначать движения разных частей человеческого тела, но и 
контролировать отдельные группы мышц, вплоть до лицевых. 

Созданные компьютером изображения уже никак невозможно отличить 
от настоящих. С середины 90-х гг. идет постоянная разработка новых 
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компьютерных программ, позволяющих создавать интерьер и натуру 
компьютерным способом.  

 
Тема 5. Композитные изображения. Создание композиций. 

 
Краткое содержание 
Теория композиции. Виды композиции: фронтальная, объемная и 

пространственная. Принципы построения композиции. Правила, приемы и 
средства композиции. Типы композиции: сюжетно-изобразительная, 
декоративно-тематическая, предметных форм и формальная. Области 
применения. Фотореалистичные композитные изображения. Создание 
композиции. Подготовка элементов изображения. Съемка элементов 
композиции. Согласование перспективы. Гармонизация света и теней. 
Согласование цвета. Подчеркивание фокуса и атмосферы.   

Создание авторского проекта. Разработка целостной эстетической 
концепции, реализуемой инструментарием векторной, растровой графики и 
анимацией. Этапы разработки проекта.  

Специальные приемы создания и использования векторной 
компьютерной графики применительно к бизнес-проектам и рекламным 
роликам. Методы использования преимуществ векторной графики в 
наружной рекламе.  

 
Основные понятия 
Слово «композиция» в переводе с латинского означает сочинение, 

составление, соединение, связь, построение, структура. Различают три 
основных вида композиции: фронтальную, объемную и глубинно-
пространственную. Такое разделение в какой-то мере условно, так как на 
практике мы имеем дело с сочетанием различных видов композиции.  

Фронтальная композиция 
Простейшей разновидностью фронтальной композиции является 

плоскостная композиция. 
Характерным признаком плоскостной композиции является 

распределение в одной плоскости элементов формы в двух направлениях по 
отношению к зрителю: вертикальном и горизонтальном, например, стенды 
наглядной агитации, ткани, ковры, фасады зданий и т.д. 

Фронтальная композиция отличается небольшой глубиной и 
преимущественно фронтальным расположением элементов. Воспринимается 
спереди. Таким образом, она приближается по своему пластическому 
характеру к плоскостной композиции. Но в отличие от нее составляется не 
просто из фактурных или рельефных плоскостей, а из глубинных или 
разделенных в плане элементов. Эти элементы отделяются от задней 
фронтальной плоскости, выдвигаются вперед, располагаясь на расстоянии 
друг от друга. Они рассматриваются уже не как рельефные, а как 
пространственные формы. В архитектурной композиции этим формам 
придается значение объемов, обращенных своей главной фронтальной 
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плоскостью к зрителю. При построении фронтально-пространственной 
композиции следует учитывать ряд важных условий. Первое - конфигурация 
форм. Она выражается в сопоставлении разных по геометрическому виду и 
расположению элементов. Чем четче это сопоставление, тем характер 
фронтально-пространственной композиции выразительнее. 

Второе важное условие – ритмическое построение композиции. 
Специфичным здесь является использование в качестве композиционного 
средства порядка смещения пространственно-плоскостных элементов 
относительно друг друга и образование нескольких ритмических групп. Из 
них и складывается простая или сложная фронтально-пространственная 
композиция. 

Третье – графическо-пластическая моделировка элементов. 
Основывается это условие на выразительной игре силуэтов, фактур, рельефов 
и разной графики - надписей, знаков, цветных плоскостей и пр. Близкое 
расположение элементов друг к другу предопределяет целостность 
фронтально-пространственной композиции. Однако оно же порой является 
причиной проявления в ней монотонности. В целях устранения последней 
требуется достижение в этой композиции пластического разнообразия форм. 
При чрезмерном же их разнообразии фронтально-пространственная 
композиция разрушается. Таким образом, главной задачей в ее построении 
становится установление различия между элементами при достижении их 
единства. 

Объемная композиция. 
Представляет собой форму, имеющую относительно замкнутую 

поверхность и воспринимаемую со всех сторон. Объемная композиция всегда 
взаимодействует с окружающей средой. Среда может увеличивать или 
уменьшать выразительность одной и той же композиции. 

Характеризуется развитием пространственных элементов в трех 
координатных направлениях при соблюдении их компактности. В 
архитектурных композициях развитие в глубину часто превалирует. 
Характер дизайнерских объемно-пространственных композиций чаще всего 
подчеркивается глубинным расположением разных по своим пластическим 
свойствам элементов – линейных, плоскостных и объемных (в подобных 
архитектурных композициях преобладают объемы). Объемно-
пространственная композиция воспринимается, как правило, с разных 
сторон, хотя часты случаи ее преимущественного восприятия с одной или 
двух сторон, например в условиях однонаправленного движения. Зритель 
находится, как правило, снаружи объемно-пространственной формы. 

В объемно-пространственной композиции имеет место более сложное, 
чем в объемной композиции, планировочное решение. Оно основывается на 
разном пространственном расположении элементов. Выбор вида часто 
обуславливается конкретной архитектурно-планировочной ситуацией, в 
которую включается объемно-пространственная композиция. 

Характер композиции рассматриваемого вида также раскрывается в 
пластической моделировке включаемых в нее элементов. Приемы такой 
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моделировки во многом схожи с теми, которые имеют место при разработке 
объемной формы. Но есть и своя специфика. В частности, в ней четко 
раскрываются доминирующие свойства разных пространственных элементов 
– их конфигурация, расположение, силуэт и членение. При этом решаются 
следующие композиционные задачи: 

выявляется общий вид геометрических пространственных форм 
(кубических, цилиндрических, пирамидальных и пр.), 

расположением подчеркивается статичный или динамичный характер 
композиции, 

остро сочетаются в пространстве разные пластические формы 
(объемные, плоскостные и линейные). 

При успешном решении этих и подобных им задач достигается 
предельная выразительность построения объемно-пространственной 
композиции. Большое значение в этом построении имеет широкое 
использование разных графическо-пластических средств, в частности цвета, 
фактуры и рельефа. В связи с таким использованием, однако, возникает 
трудность упорядочения в объемно-пространственной композиции 
значительного количества разных по свойствам элементов. Ее преодолению 
способствуют четкая планировочная организация пространства, а также 
единый характер включаемых в него пластических элементов. 

Глубинно-пространственная композиция 
Складывается из материальных элементов, объемов, поверхностей и 

пространства, а так же интервалов между ними. Данный вид композиции в 
архитектуре используется повсеместно: от решения интерьеров помещений 
до разработки улиц, площадей, микрорайонов и т.п. 

Характеризуется преимущественным развитием в глубину и 
восприятием изнутри. Последний признак предопределяет ее важное 
художественное значение в дизайнерском творчестве. Выражается оно в 
широком включении разных пластических форм в глубинное пространство. 
Его протяженность определяется отношением глубины пространства к 
ширине. При отношении менее чем 1:1 пространство характеризуется как 
относительно неглубокое (поперечное), при отношении более чем 1:1 – как 
глубокое (продольное). При отношении, равном 1:1, - средней   глубины. 

Важный композиционный признак или художественное свойство 
глубинного пространства – открытость. Степень открытости выражается 
отношением глубины пространства к высоте ограничивающих его 
плоскостей. Если отношение больше чем 2:1, то пространство считается 
открытым, если меньше – замкнутым. Вполне оправдано уточнение этих 
данных в связи с обращением к масштабной характеристике пространства и 
его подразделением на неограниченное (открытое) и ограниченное 
(замкнутое). 

 
Сюжетно-изобразительная (повествовательная) композиция лежит в 

основе реалистических художественных произведений (живописных, 
скульптурных и т. д.). В ней участвуют "реальные" персонажи. Их 
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отношения и действия взаимно обусловлены, у каждого своя роль. 
Противостояние объектов композиции служит выявлению их сущности, 
качественных характеристик. Эти отношения типичны, они выделены, 
выхвачены из более общего содержания, контекста. Произведение требует 
внимательного вдумчивого рассмотрения, и, как правило, вызывает 
обобщение от частного к общему. 

Пример сюжетно-изобразительной композиции - реалистичное 
произведение станковой живописи. Его цель - рассказать зрителям о каком-
либо явлении или событии и выразить отношение художника к этому 
событию (рис. CD-3.59). Такое произведение автономно, самодостаточно. 
Оно не должно зависеть от окружения, хотя интерьер, в котором висит 
картина, несомненно, влияет на восприятие. 

Декоративно-тематическая композиция. Как правило, дизайнерам 
приходится создавать декоративные композиции. В этом случае, в 
тематической композиции сюжетный рассказ подчиняется декоративным 
целям, и это подчеркивает и глубже раскрывает смысл произведения. Такая 
композиция вписывается обычно в какие-либо архитектурные формы или 
связывается с другими произведениями прикладного искусства, и, 
следовательно, само является частью другой, большей композиции. Часто 
декоративно-тематические композиции используются в плакатах, в народном 
искусстве, в оформлении книг (обложки, экслибрисы), в интерьерах 
общественных зданий, офисов. 

Для создания такого произведения нужно найти обобщенный образ. Он 
должен быть емким и лаконичным. Для этого, в первую очередь, нужно 
понять суть темы и выбрать главное, стержень композиции, отказаться от 
ненужных подробностей. Художник сам определяет, какие качества предмета 
нужно выделить для более полного раскрытия темы. Например, в 
композиции на тему "Дерево" можно передать контур, геометрию дерева, 
можно изобразить одну ветку с листьями, а можно дать увеличенное 
изображение фактуры коры дерева с капелькой смолы. Решений множество, 
главное, чтобы изображение подчинялось декоративным целям. 

Формальная композиция строится из линий и пятен, она выражает 
логику композиционного построения. Иногда такой тип композиции 
называют неизобразительной. Это пространство художественных образов, не 
существующих в реальности, не имеющих рационально-практической 
значимости. В формальной композиции важен не сюжет, а исключительно 
законы и принципы ее собственного построения, пластические формы. Ее 
содержание формально. Эмоциональное воздействие на зрителя оказывает 
художественная форма, цветовой и пластический строй произведения. 

Элементы любого композиционного произведения – объект и 
пространство, но, в отличие от рассмотренных ранее типов, в формальной 
композиции используются не реально существующие предметы (предметные 
формы), а абстрактные объекты. Эти объекты могут возникнуть в результате 
предельного упрощения форм реальных предметов или быть созданы из 
геометрических фигур, знаков алфавита. 
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Тема 6. Цифровая фотография.  

 
Краткое содержание 
Природа цифрового изображения. Способы получения цифровых 

изображений. Цифровая фотография: студийная и экстерьерная съемка. 
Визуализация цифрового изображения. Входные и выходные характеристики 
изображения: линейный размер, входное и выходное разрешение 
изображения. 

Цветовые простанства Bitmap, Greyscale, Duotone, Index, RGB, CMYK, 
HSB, Lab. Их назначение. Преобразование цветовых пространств. Глубина 
цвета. Цветовоспроизводящие устройства: Adobe RGB, Apple RGB, sRGB, 
Euroscale, SWOP Color Managment Systems.  

 
Основные понятия 
Цветовая модель — математическая модель описания представления 

цветов в виде кортежей чисел (обычно из трёх, реже — четырёх значений), 
называемых цветовыми компонентами или цветовыми координатами. Все 
возможные значения цветов, задаваемые моделью, определяют цветовое 
пространство. Цветовая модель задаёт соответствие между 
воспринимаемыми человеком цветами, хранимыми в памяти, и цветами, 
формируемыми на устройствах вывода (возможно, при заданных условиях). 

Grayscale (Градации серого цвета) — цветовой режим в котором 
пиксели изображения окрашены в 256 оттенков серого цвета — от нуля 
(черный цвет) до 255 (белый цвет).После преобразования в режим Grayscale 
изображение содержит оттенки черного цвета с яркостью от 0 (белый) до 
100% (черный). Во время преобразования цветного рисунка в эту цветовую 
модель каждый цвет, в зависимости от его яркости, заменяется 
соответствующим оттенком серого. 

Bitmap — черно-белый цветовой режим, в котором все пиксели 
изображения окрашены только черный и белый цвета. Этот режим можно 
использовать для изображений с неявными и слабовыраженными цветовыми 
переходами.  
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Модель Duotone или дуплекс (двуцвет или дуотон) - это 8-разрядный 
цветовой режим, использующий 256 оттенков из не более чем четырех 
цветовых тонов. Duotone расширяет тоновый диапазон, а также позволяет 
тонировать полутоновые изображения. В режиме Duotone изображение 
может быть одноцветным (monotone), двуцветным (duotone), трехцветным 
(tritone) и четырехцветным (quadtone). 

Модель Indexed Color - индексированная (фиксированная) цветовая 
палитра содержит не более 256 цветов. Используется для размещения 
изображений во Всемирной паутине или мультимедийных презентаций. В 
этой модели сильно ограничены возможности редактирования изображений. 

Модель RGB – это способ отображения подавляющего большинства 
цветов видимого спектра  благодаря смешиванию  трех цветов (в разных 
пропорциях и с разной яркостью) — красного, зеленого и синего (Red, Green, 
Blue — RGB). Цвет в модели RGB называется аддитивным. 

Аддитивные цвета в некоторых электронных устройствах формируется 
благодаря бомбардировке люминофора электронными пучками красного, 
зеленого и синего цветов. Яркость каждого из базовых цветов (красный, 
зеленый, синий) в модели RGB определяется значением в диапазоне от 0 до 
255, т.е. в цветовую модель входит по 256 оттенков красного, зеленого и 
синего цветов, а также любая комбинация этих оттенков. Если значения 
красного, зеленого и синего цветов равны нулю, то при смешивании этих 
трех цветов получим черный цвет; если же значения яркости равны 255 — 
получим белый цвет. 

 
Модель HSB основана на восприятии цветов окружающего мира 

центральной нервной системой человека. У этой модели есть три 
фундаментальных параметра — оттенок (Hue), насыщенность оттенка 
(Saturation) и его яркость (Brightness). Цвет луча света, который отражается 
или проходит сквозь какой-либо объект, в данной модели называют 
оттенком. Оттенки цветов, которые измеряют в градусах (от 0° до 360° 
цветового круга), однозначно идентифицируют по названию цветов 
(например, красный или зеленый). Насыщенность — это уровень 
присутствия серого цвета в определенном оттенке. Измеряют насыщенность 
(или, как ее еще называют, чистоту оттенка) в процентном соотношении 
содержания серого цвета от 0% (серый цвет) до 100% (чистый оттенок). 
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Яркостью называют уровень осветления или затенения оттенков, ее 
измеряют в процентах от 0% (черный цвет) до 100% (белый цвет). 

Хотя модель HSB декларирована как аппаратно-независимая, на самом 
деле в её основе лежит RGB. В любом случае HSB конвертируется в RGB для 
отображения на мониторе и в CMYK для печати,а любая конвертация не 
обходится без потерь. 

Модель CMYK (сокращение от Cyan-Magenta-Yellow-Black - голубой-
пурпурный-желтый-черный) - это цветовая модель, в которой все цвета 
описываются как смесь этих четырех обрабатываемых цветов. CMYK - 
стандартная цветовая модель, используемая в цветной печати. Т.к. здесь 
используются чернила четырех основных цветов, ее еще называют 
четырехцветной печатью.   

Цветовая модель CMYK в отличие от RGB описывает поглощаемые 
цвета. Цвета, которые используют белый свет, вычитая из него определённые 
участки спектра, называются субтрактивными (вычитательными). Именно 
такие цвета и используются в модели CMYK. Они получаются путём 
вычитания из белого аддитивных цветов модели RGB. Основными цветами в 
CMYK являются голубой (Cyan), пурпурный (Magenta) и жёлтый (Yellow). 
Голубой цвет получается путём вычитания из белого красного цвета, 
пурпурный - зелёного, жёлтый – синего. При смешении всех трёх цветов 
получается чёрный цвет, т.е. сложение цветов в CMYK аддитивно. Цветовая 
модель CMYK является основной для печати. В цветных принтерах также 
применяется данная модель.  
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Для того, чтобы распечатать чёрный цвет, необходимо большое 
количество краски. Смешение всех цветов модели CMYK даёт не чёрный, а 
грязно-коричневый цвет. Для усовершенствования модели CMYK, в неё был 
введён один дополнительный цвет - чёрный. Он является ключевым цветом 
при печати, поэтому последняя буква в названии модели - K (Key), а не B. 
Таким образом, модель CMYK является четырёхканальной. У CMYK 
цветовой охват более узкий, чем у RGB. Поэтому, при конвертации из RGB в 
CMYK часть цветов теряется. Это необходимо учитывать. 

Модель Lab. В цветовом пространстве Lab значение светлоты отделено 
от значения хроматической составляющей цвета (тон, насыщенность). 
Светлота задана координатой L (изменяется от 0 до 100, то есть от самого 
темного до самого светлого), хроматическая составляющая — двумя 
декартовыми координатами a и b. Первая обозначает положение цвета в 
диапазоне от зеленого до пурпурного, вторая — от синего до желтого.  

 
В отличие от цветовых пространств RGB или CMYK, которые являются, 

по сути, набором аппаратных данных для воспроизведения цвета на бумаге 
или на экране монитора (цвет может зависеть от типа печатной машины, 
марки красок, влажности воздуха на производстве или производителя 
монитора и его настроек), Lab однозначно определяет цвет. Поэтому Lab 
нашел широкое применение в программном обеспечении для обработки 
изображений в качестве промежуточного цветового пространства, через 
которое происходит конвертирование данных между другими цветовыми 
пространствами (например, из RGB сканера в CMYK печатного процесса). 
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При этом особые свойства Lab сделали редактирование в этом пространстве 
мощным инструментом цветокоррекции. Благодаря характеру определения 
цвета в Lab появляется возможность отдельно воздействовать на яркость, 
контраст изображения и на его цвет. Во многих случаях это позволяет 
ускорить обработку изображений, например, при допечатной подготовке. Lab 
предоставляет возможность избирательного воздействия на отдельные цвета 
в изображении, усилиения цветового контраста, незаменимыми являются и 
возможности, которые это цветовое пространство предоставляет для борьбы 
с шумом на цифровых фотографиях. 

Модель Multichannel. В мультиканальной (многоканальной) модели 
каждый из каналов изображения содержит 256 уровней серого. Может 
содержать любое количество цветовых каналов. Общее количество цветовых 
и альфа-каналов не может превышать 56-ти. Эта модель используется для 
специальных режимов печати, например, при использовании заказных 
(плашечных) цветов, а также при некоторых преобразованиях из одной 
цветовой модели в другую. 

 
 

Тема 7. Компьютерная графика в  веб-пространстве. Ресурсы 
компьютерной графики в Интернет 

 
Краткое содержание 
Веб-графика: особенности и ограничения. Виды веб-графики: визуал, 

фоновая, навигационная, логотип, фовикон, банер. Форматы графических 
изображений в Интернет. Системы представления цвета в Интернет 
(Цветовые модели. Базовые цвета.). 

Веб-анимация. Флэш- и gif- технологии. 
Подготовка графических изображений для публикации (размещения) в 

сети Интернет. Оптимизация размера графического файла. Разрезание 
изображения. Изображения-карты. 

Создание дизайна веб-сайтов. Программное обеспечение веб-дизайнера: 
технологические средства разработки макетов сайта, специализированные 
графические редакторы, инструменты юзабилити-тестирования сайта. 

Вставка графических изображений. Способы указания источника файла 
для изображений. Размеры изображений, выравнивание, обтекание текстом, 
отступы, рамки, альтернативный текст. Использование графических 
изображений в качестве фона веб-страницы. Создание веб-анимации и 
интерактивных эффектов. Создание банера. Указание гиперссылки. 

Поиск графической информации в Интернет. Профессиональные 
ресурсы КГ в Интернет: фасетные базы данных графических изображений и 
3D моделей, фотобанки, форумы, веб-сервисы. Ресурсы изобразительного 
искусства в Интернет. Базы репродукций произведений искусства.  

 
Основные понятия  
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Веб-графика используется для интернет-ресурсов. Одна небольшая 
картинка может заменить целую страницу текста. В информационном 
содержании/ Главной особенностью графики в Web-дизайне является то, что 
сопровождается текстовой информацией и элементами интерфейса 
(кнопками, переключателями и т. п.), это необходимо учитывать при 
создании изображений. Основное назначение графики в том, чтобы привлечь 
внимание к Web-странице в целом или к отдельным ее фрагментам, а также 
представить информацию, которую словами не опишешь.  

Другая особенность графики для Web заключается в жестких 
ограничениях, накладываемых на объем файлов. Это связано с пропускной 
способностью каналов связи. Если Web-страница загружается в браузер 
дольше 10 с. это считается плохим показателем разработки ресурса. 
Дизайнеры стремятся к тому, чтобы Web-страница не превышала по объему 
50 —60 Кбайт. Для этого необходимо хорошо разбираться в форматах 
файлов и способах монтирования изображений в Web-страницу.  

Третья особенность графики состоит в том, что компьютеры в мире 
построены на различных платформах. Так, существуют компьютеры на 
платформе PC и на платформе Macintosh. Мониторы этих компыотеров 
имеют различную яркость. Если этого не учитывать, то одна и та же 
картинка, хорошо выглядящая на одном мониторе, может потерять свою 
выразительность на другом.  

В Интернет, в первую очередь пользователь имеет дело с документами, 
которые передаются с веб-сервера на локальный компьютер  и 
просматриваются с помощью браузера. Это накладывает свой отпечаток на 
объем графических файлов, их форматы, а также качество.  

Под фотографическими изображениями понимаются полноцветные 
фотографии, чёрно-белые фотографии, полноцветные изображения, рисунки 
с большим количеством разноцветных деталей. Под графикой, логотипами, 
иконками — графика со множеством сплошных цветов, с небольшим 
количеством цветов (до 256 цветов), с линиями, и текстом. 

Форматы графических изображений 
Формат GIF (Graphics Interchange Format). Формат GIF имеет цветовую 

палитру, состоящую из 256 цветов. Алгоритм GIF выбирает 256 наиболее 
используемых в исходном изображении цветов, а все остальные оттенки 
создаются путём подмешивания — подбора соседних пикселей таким 
образом, чтобы человеческий глаз воспринимал их как нужный цвет. По этой 
причине GIF не подходит для хранения полноцветных изображений и 
фотографий. Формат поддерживает прозрачность — каждый пиксель 
изображения может быть в двух состояниях: прозрачный или непрозрачный, 
полупрозрачность не поддерживается. Особенностью GIF является 
поддержка анимации, то есть этот формат может хранить несколько кадров, 
которые сменяют друг друга с определённой частотой. 

Формат JPEG (Joint Photographic Experts Group) получил своё название 
от объединённого комитета экспертов по фотографии, который  создал этот 
стандарт в конце 80-х — начале 90-х годов. Он был разработан для сжатия и 
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хранения полноцветных фотографий. Поддерживает более 16 миллионов 
цветов. Формат JPEG сжимает изображения с потерей качества. Алгоритм 
сжатия основан на разбиении исходного изображения на квадраты 8×8 
пикселей, и последующей их группировке. Можно получать JPEG 
изображения очень маленького веса, но только за счёт ухудшения качества 
картинки, можно получить и очень качественные JPEG, но тогда картинка 
будет слишком тяжёлой. Поэтому главная задача при работе с JPEG — 
подобрать такой уровень качества, чтобы вес был небольшой и качество 
картинки было приемлемым (обычно, это диапазон от 60 до 70, но нужно 
тестировать на каждой картинке). 

Формат PNG (Portable Network Graphics) является альтернативой для 
GIF-файлов. PNG является форматом сжатия без потерь и позволяет 
сохранять изображения, в которых требуется особенная чёткость. Например, 
чертежи и печатный текст. Формат имеет две вариации: PNG8 и PNG24. 
PNG8 может хранить лишь 256 цветов, а PNG24 использует уже более 16 
миллионов цветов. Главная особенность формата PNG — поддержка альфа-
прозрачности, то есть каждому пикселю в отдельности можно задать свою 
степень прозрачности. 

Формат WebP — новый формат, созданный и развиваемый с 2010 года 
компанией Google. Главная цель этого проекта — ещё больше уменьшить вес 
при сохранении такого же качества. Формат использует новый алгоритм 
сжатия, в котором искажения отличаются от искажений других форматов. 
Ухудшается детализация и структура, в то время как края остаются чёткими. 
WebP поддерживается браузерами Chrome, Opera и Firefox. 

Особенности WebP: 
- сжимает изображения без потерь лучше, чем PNG (на 26% по данным 

Google); 
- сжимает изображения с потерями лучше, чем JPEG (на 25–34% по 

данным Google); 
- поддерживает прозрачность (альфа-канал). 
GIF, JPEG, PNG, и WebP — растровые форматы, основанные на 

дискретном (пиксельном, точечном) представлении изображения, в то время 
как векторные форматы основаны на математических формулах 
(геометрическом представлении фигур).  

Формат SVG (Scalable Vector Graphics) переводится как — 
масштабируемая векторная графика. Формат существует с 1999 года. Размер 
объектов SVG намного меньше размера растровых изображений, а сами 
изображения не теряют в качестве при масштабировании. В отличие от 
растровых форматов мы можем взаимодействовать с изображениями в 
формате SVG — при помощи CSS можно изменять параметры графики: цвет, 
прозрачность или границы, а при помощи JavaScript — анимировать 
изображение. 

SVG поддерживается почти всеми браузерами за исключением Internet 
Explorer 8 и ниже, эта проблема решается подключением JavaScript-
библиотек, например, SVGeezy. 
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Формат SVG отлично подходит для малоцветных схем, логотипов и 
иконок. 
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Тема 8. Допечатная подготовка.  
 
Краткое содержание 
Основы допечатной подготовки. Операции, завершающие 

производственный процесс. Подготовка к тиражированию экранной и 
полиграфической продукции. Подготовка к печати растровых изображений и 
векторных иллюстраций.  

Краски для печати: триадные и смесевые. Цветоделение. Перекрытие 
цвета и треппинг. Растискивание. Цветопробы.  

Калибровка. Цветовые профили. Способы калибровки: регулировка 
настроек монитора, регулировка настроек принтера, использование пары 
ICC-профилей для изменения файла в процессе печати, изменение 
определения RGB или CMYK профилей в Photoshop, формирование 
корректирующих кривых. 

Цифровые шрифты. Методы описания символов. Форматы 
компьютерных шрифтов: Аdobe Type1, True Type. Язык описания Post Script. 
Основные принципы установки и деинсталляции шрифтов.  

Тенденции развития современных графических систем. 
 
Основные понятия 
Допечатная подготовка – это комплекс мероприятий, позволяющий 

воспроизвести точную копию оригинал-макета при помощи печатного 
процесса, а также учет и исправление ошибок, которые могут возникнуть при 
печати. 

К допечатной подготовке относятся следующие операции: 
– проверка оригинал-макета на наличие ошибок; 
– цветокоррекция изображений; 
– цветоделение; 
– учет потенциальных проблем при печати (обеспечение 

воспроизведения насыщенных цветов, профилактика растровых разрывов и 
т.д.); 

– запись PS-файла; 
– растрирование; 
– вывод печатных форм.  
Макет дизайна проверяется на расположение значимых элементов 

вблизи линии реза и в корешке. Обычно, эта величина не должна быть менее 
5 мм. Необходимо грамотно расположить элементы на полосе, идущие на 
вылет (bleed), им следует задать размер вылета. Стандартно - 5 мм. При 
размещении изображений на вылет необходимо следить, чтобы не зарезались 
значимые элементы работы.  

Важный аспект – это грамотное размещение изображений на развороте. 
Согласно правилам препресс, нежелательно чтобы основные объекты 
попадали на разворот.  

В процессе допечатной подготовки издания обычно применяется два 
этапа работы с изображениями. Первоначально делается первичная 
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обработка изображений: цветокоррекция; ретушь. Следует учитывать, что 
векторные полутона, градиенты и прозрачности должны быть растрированы, 
растровые элементы, изображения – должны быть в формате «CMYK» и 300 
dpi. Полноцветные изображения представляются в «CMYK»-модели и 
должны иметь стандартное разрешение для печати при полном масштабе, а 
насыщенность цвета - от 9 до 95 %. Во избежание потери качетва, все 
сложные элементы обычно растрируются. 

Необходимо указывать наличие или отсутствие белой подложки. Все 
шрифты и тексты должны быть переведены в кривые, а черный текст – в 
«over print». В первичной обработке художественных элементов  
присутствуют обтравка; «total ink limit» согласно выбранному типу печати и 
бумаге; переименование файлов согласно принятым специалистами по 
допечатной подготовке правилам - латинские буквы без пробелов, а также 
сохранение изображений в правильном формате («tiff» или «psd»).  

Второй этап представляет собой работу с вёрсткой. Здесь необходимо – 
наращиваются вылеты.  

Для изображения устанавливается масштаб 100% и разрешение согласно 
выбранной линиатуре печати. В самом конце производится процедура 
предпечатной обработки изображений. 

Для правильного совмещения красок в оттисках следует поставить в 
макете приводочные метки или «приводочные кресты». Приводочные кресты 
служат для контроля совмещения красок на оттиске при печати и для оценки 
точности приводки после печати, находятся они в обрезном поле, при 
отделке печатной продукции их удаляют. Также в обрезном поле 
присутствует шкала оперативного контроля качества печати. 

Обрезные меткии (линии), используются для обозначения обрезного 
формата издания, они служат руководством при окончательной обрезке 
издания.Метки, созданные из верстки, предназначены для контроля 
позиционирования полосы в спуске, поэтому важно их отодвинуть от 
обрезного формата на несколько мм.  

Следующая задача допечатной подготовки – проверка вёрстки с точки 
зрения соответствия техническим требованиям типографии. Для этого 
необходимо правильно сконфигурировать среду и настроить программу 
вёрстки (в данном случае – например «Scribus»).  

PostScript - язык описания страниц, в основном используемый в 
настольных издательских системах. Это конкатенативный язык 
программирования с динамической типизацией. PostScript является языком 
управления принтером, а так же полнофункциональным языком 
программирования. Многие прикладные программы могут преобразовать 
документ в PostScript-программу, при выполнении которой будет получен 
начальный документ. Эта программа может быть послана непосредственно 
на принтер с поддержкой PostScript или преобразована интерпретатором 
PostScript в другой формат (для принтеров без поддержки PostScript), или 
результат её выполнения интерпретатором может быть показан на экране. 
Так как исходная PostScript-программа одна и та же, PostScript называется 
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независимым от устройства. Большинство высокопроизводительных 
принтеров и плоттеров имеют встроенный интерпретатор языка PostScript. В 
то же время, простые принтеры домашнего класса поддерживают только 
элементарные графические операции, поэтому задача создания растрового 
изображения возлагается на центральный процессор. Существуют 
интерпретаторы языка PostScript для различных операционных систем. 
PostScript — полнофункциональный тьюринг-полный язык 
программирования. Программы на PostScript создаются в основном не 
людьми, а другими программами, однако это не исключает того, что человек 
может писать на нем программы для обсчёта графики, реализации численных 
методов решения математических задач и т. п.  
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ПРАКТИЧЕСКИЙ РАЗДЕЛ 
 

Тема 5. Композитные изображения. Создание композиций. 
 

Инструменты и приемы создания выделенных областей. 
Профессиональные приемы выделения. Типы выделенных областей. 
Выделенные области геометрической формы. Цветовые выделенные области. 
Работа в режиме быстрой маски. Контуры. Работа с инструментом Pen. 
Комбинирование контуров и выделенных областей. Перемещение каналов и 
выделенных областей. Выделение мелких деталей. Выделение прозрачных 
объектов. Вычисления. Выделение движущихся объектов. 

Маскирование слоев. Типы масок: маска слоя, обтравочная маска, 
векторная маска. Работа с альфа-каналами. Приемы работы с альфа-масками.  

Теория композиции. Виды композиции: фронтальная, объемная и 
пространственная. Принципы построения композиции. Правила, приемы и 
средства композиции. Типы композиции: сюжетно-изобразительная, 
декоративно-тематическая, предметных форм и формальная. Области 
применения. Фотореалистичные композитные изображения. Создание 
композиции. Подготовка элементов изображения. Съемка элементов 
композиции. Согласование перспективы. Гармонизация света и теней. 
Согласование цвета. Подчеркивание фокуса и атмосферы.   

Основы комбинирования изображений. Работа с режимами наложения. 
Режимы смешения слоев. Режим Screen. 

Масштабирование с минимальными потерями. Автоматизация работы.  
Создание авторского проекта. Разработка целостной эстетической 

концепции, реализуемой инструментарием векторной, растровой графики и 
анимацией. Этапы разработки проекта. Освоение традиционных методик 
живописи и графики и транспонирование их в компьютерные творческие 
технологии. 

Специальные приемы создания и использования векторной 
компьютерной графики применительно к бизнес-проектам и рекламным 
роликам. Методы использования преимуществ векторной графики в 
наружной рекламе.  

 
Лабораторная работа 1 

Ретушь 
Из этого урока Вы узнаете, как сделать свою кожу матовой и гладкой, 

как у моделей на обложках глянцевых журналов. 
Шаг 1 
Откройте изображение в Фотошопе, дублируйте его. 
Удалите все неровности на коже с помощью 

Лечащей/Восстанавливающей кисти .  
Шаг 2 
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Как только вы закончите работу с инструментом , дублируйте слой 
еще раз и примените к нему Фильтр - Шум - Пыль и царапины (Filter > Noise 
> Dust & Scratches) 

 

Для своего примера я использовала настройки такие:  
радиус 5 px и порог 0. 

Но знайте, что настройки зависят от качества фотографии.  
В результате мы должны получить мягкое размытие изображения, примерно 
так: 

 

Шаг 3 
Следующий фильтр, который мы будем использовать, Размытие по 

Гауссу (Filter > Blur > Gaussion Blur) 
И снова настройки на ваше усмотрение, у меня радиус = 2. 

 

Шаг 4 
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И финальный шаг в создании новой матовой кожи - это добавление еще 
одного фильтра Шум - Добавить шум (Filter > Noise > Add Noise).  

Мы все прекрасно знаем, что человеческая кожа не может быть 
идеально гладкой. Благодаря этому фильтру кожа примет нужную текстуру и 
будет смотреться более реалистично. 

Я использовала монохромный шум в количестве 0.7%. 
 

Шаг 5 
Новая кожа для модели готова! 
Внизу палитры слоев нажмите на кнопку Добавить маску слоя (Add a 

layer mask). Рядом со слоем появится белый квадратик. 
Возьмите , установите черный цвет и кликните по документу.  

Если не получается, то убедитесь что в качестве основного цвета стоит 
черный, затем нажмите Alt+Backspace 
Что произойдет? "Мутный" слой спрячется, а нижний "четкий" появится. 

 

Шаг 6 
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А вот теперь начинается самая интересная часть! Сейчас мы будем 
накладывать на модель идеально гладкую кожу. Чтобы все сделать 
правильно, послушайте следующие рекомендации: 

Возьмите инструмент Кисть, убедитесь, что выбран именно белый цвет. 
Установите жесткость кисти на 0. Вы можете также уменьшить ей 
прозрачность. (Будет лучше, если вы в процессе будете возвращаться к 
настройкам и корректировать их по мере необходимости) 

Итак, мы находимся на маске слоя.  
Ваша задача - красить белой кистью в тех местах, где кожу нужно 

обновить, но не затрагивать глаза, брови, губы, волосы, чтобы они не 
потеряли свою резкость. 

Если вы случайно закрасили лишнего, то переключитесь на черную 
кисть и все исправьте. 

Палитра слоев: 
 

Шаг 7 
Кожа у девушки приятного цвета, поэтому никаких цветовых настроек 

применять не будем.  
Но если у вас другая ситуация, то помните, что есть такие параметры, 

как Цветовой тон/насыщенность, фотофильтр, цветовой баланс, которые 
всегда будут рады вам помочь. 

Шаг 8 
А теперь мы добавим немного резкости нашему изображению. 
Дублируйте средний слой, у меня называется "леч кисть". Измените ему 

режим смешивания на Перекрытие (Overlay).  
Примените Фильтр - Другие - Цветовой Контраст (Filter > Other > High Pass) 

Установите значение радиуса по своему вкусу, помните, что всегда 
этому слою можно уменьшить прозрачность 
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Если вы хотите добавить еще больше шика, то следуем дальше. 
Шаг 9. 
Слейте все слои, кроме последнего (чтобы самим было интересно 

посмотреть, как было и как стало) 
Дублируем верхний слой, режим наложения меняем на Перекрытие 

(Overlay). Будет примерно так: 
 

Добавляем фильтр Размытие по Гауссу: 
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Добавим маску слоя и уберем черной кистью размытость с волос, чтобы 
оставить их блеск.  

Немножко добавим резкости. Применяем Фильтр - Резкость - Контурная 
резкость (Sharp - Unsharp mask) 2 раза.  

Самое любимое - это итоговое сравнение: 
 

 
 

Лабораторная работа 2 
Маска для ретуши  

 
Данный урок покажет нам как обычному портрету придать вид портрета 

из глянцевого журнала. А так же здесь будет показана техника ретуши, что 
даст вам большую точность и контроль за действиями. 

 
Некоторые шаги в этом уроке сложны для новичков, но если вы поймете 

принципы, особенно принципы работы новых слоев для применения каждого 
отдельного эффекта и смысл работы маски при ретуши, то ваша работа 
перейдет в совершенно новое качество. 

Этот урок даст вам основы ретуши. Это подразумевает, что вы 
используете эти навыки, расширите их - добавите ваше собственное 
мастерство, видение и цели. Есть множество способов сделать ретушь в 
Photoshop и этот урок покажет только один способ как придать гламурный 
вид портрету и подтолкнет вас к мысли, что лучше для вас и для вашей 
работы. 

Наш процесс состоит из 5 шагов: 1. регулировка цвета и коррекция 
яркости. 2. ретушь дефектов кожи и других пятен. 3. добавление гладкости 
кожи. 4. добавление теней. 5. добавление шума или текстуры кожи.  

Здесь несколько образцов. Заметьте как вы можете контролировать 
степень и силу ретуширования, подбирая под свой вкус и надобности. 
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 Шаг 1.  
Сначала ВСЕГДА делайте копию слоя для работы и сохраняйте 

оригинал фото на самом нижнем слое. Это сохранит ваш оригинал от 
необратимых изменений.  

Итак, продублируйте слой. 
Есть три способа это сделать. 
Первый - Menu> Layer> Duplicate Layer. Второй – используйте 

сочетание клавиш Ctrl+J (Option+J). И, наконец, вы можете сделать копию 
слоя, перетащив иконку слоя на кнопку "New Layer Button" в низу палитры 
слоев. 

В данном случае  мы имеем плохоотсканированный снимок с пленки. 
Кадр выглядит желтым и безжизненным. Поэтому нам понадобится Цветовая 
коррекция. 

  Сделайте первую коррекцию с помощью команды Сolor Balance 
(Ctrl+B). Подтяните ползунки так, как показано на рисунке:

        
Это может показаться нудным, но каждое последующее действие мы 

будем производить на отдельном слое и, исходя из манипуляций, давать 
слою название. Позже это даст вам возможность быть более креативными и в 
финале подкорректировать все параметры по вашему вкусу. 

 Следующую коррекцию совершаем  с помощью уровней Levels (Ctrl+L) 
на новом, третьем слое. Назовите слой "Level Corrections". 
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Используя инструменты Levels (Ctrl+L) и Curves (Ctrl+M) мы можем 
изменить в целом яркость, темные и средние тона.  

Выберите Menu> Image> Adjustments> Curves (Ctrl+M). Инструмент 
Curves используется обычно, когда нужно повысить средний тональный 
диапазон (гамма) изображения и сделать его ярче. Кликните в центре кривой 
и потяните центр  вправо или влево, что бы убрать тусклость и излишнюю 
затемненность или яркость. Нам нужны чистые средние тона изображения. 

 
(рис. Сдвиньте кривую таким образом, чтобы придать картинке больше 

яркости) 
Коррекция с помощью инструмента Curves.(Ctrl+M) 
Коррекция Curves – потяните за центр кривой и отрегулируйте тон 

изображения. 
Коррекция с помощью Levels 
Двигайте левый (черный) ползунок ближе к краю гистограммы, что бы 

откорректировать черные тона в изображении. Затем двигайте правый 
(белый) ползунок к краю гистограммы, что бы увеличить общую яркость 
картинки в области светов. Используйте серый (средний) ползунок для 
коррекции средних тонов. Вам нужно получить чистые и точные тона 
картинки. Это хорошо, если у вас будет немного чистого белого цвета в 
изображении, немного черного и широкий диапазон средних тонов. 
Экспериментируйте! 
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(рис. Сдвиньте крайние ползунки гистограммы, отрегулируйте средние 

тона изображения) 
: если вы никогда не использовали калибратор для настройки яркости и 

цветности вашего монитора, то вы можете получить непредсказуемый 
результат при печати ваших изображений. Картинки на мониторе чаще 
всего выглядят светлее либо темнее. Так что желательно иметь 
откалиброванный монитор для работы с изображениями. 

Итак, наше изображение как следует отрегулировано при помощи Levels 
– белая и черная точки, широкий диапазон средних тонов…. Мы подготовили 
изображение для второго шага. Будем избавляться от пятнышек и морщин. 

Шаг 2. Ретушь пятнышек. 
Все мы с вами несовершенны и часто, листая глянцевые журналы 

(больше, конечно, девушки), кусаем губы от зависти и желания иметь такую 
же гладкую и идеальную кожу. Нужно сказать, что модель, талантливый 
фотограф и профессиональный визажист могут вместе создать оригинальный 
образ. Большинство из нас хотело бы выглядеть как такая модель. Этот урок 
и дает нам общие принципы как сделать подобный образ, близкий к 
журнальному. Чем лучше оригинал, тем лучше результат! 

Итак, давайте начнем справляться с недостатками. Мы должны убрать 
все пятна, если они не существенны. Мы будем делать ретушь это на одном 
или двух отдельных слоях для полного контроля.  

Создайте новый чистый слой над слоем с Levels (зайдите в палитру 
слоев Layer>New>Layer или нажмите внизу палитры слоев Add New Layer 
(Shift+Ctrl N ). Назовите этот слой «прыщики-морщинки». Дважды кликните 
на слое и переименуйте его.  

Если вы хотите получить чересчур гладкую кожу, вы можете создать 
второй корректирующий слой. На этом втором слое вы будете устранять 
значительные морщины вокруг носа, рта, под глазами и вокруг подбородка и 
шеи.  

Первый слой - для коррекции маленьких пятнышек (прыщики, цветные 
пятнышки, морщинки…). Второй слой – для коррекции более сложных 
вещей. После ретуши лицо может выглядеть слегка не натурально, но у нас 
есть возможность смешать отредактированный и неотредактированный слои 
для более полного контроля за результатом. Поэтому каждый шаг лучше 
делать на отдельном слое. Это дает нам возможность, играя opacity 
(прозрачностью) или работая с маской, достигать более гибкого результата.  

Если вас не устроил результат работы, вы можете спокойно удалить 
слой и начать снова.  

Новый инструмент CS2 Spot Healing Brush просто превосходен для 
ретуши. Одно прикосновение кисти к пятну и оно автоматически исчезает 
без необходимости использовать образец или еще какую-либо коррекцию! 
Это самый быстрый инструмент для удаления пятен. Если вы слишком 
размазываете изображение, можно откорректировать размер кисти, ее 
жесткость. Единственное, о чем вы должны помнить – делайте кисть слегка 
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больше, чем корректируемое пятно. Используйте клавиши [ ] ,чтобы 
изменить размер и Shift, чтобы изменить жесткость кисти. Также можно 
использовать обычную CS Healing Brush, где вам нужно использовать 
образец области с нажатой клавишей Alt. Иногда при коррекции темных 
областей или текстуры лучше использовать инструмент Patch. И конечно же 
Clone Stamp Tool. Здесь вы также используете клавишу Alt, но клонируемый 
образец ложится поверх, не смешиваясь с нижним слоем текстуры как в Spot 
Healing Brush и Healing Brush. Мне также известно, что можно использовать 
обычную кисть. Для этого берем образец цвета кожи с помощью клавиши Alt 
и затем просто рисуем. Иногда это помогает настроить "brush blend mode" 
таким образом, что происходит замена только цветовой информации.  

(Два замечания: будьте уверены, что вы работаете на новом слое. 
Будьте уверены, что в окошке the "Sample All Layers" в палитре options 
стоит чекбокс и выбран слой на котором вы собираетесь производить 
ретушь. Чаще всего я использую при ретуши значение opacity для кисти не 
более 20%. Это позволяет мне положить много прозрачных слоев и 
наращивать их постепенно, чтобы добиться гладкости. 100% opacity вашей 
кисти даст эффект жесткости и ненужную резкость.) 

 
Не забываем о морщинках в области шеи: 
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Когда вы закончите ретушь/ ваш новый Blemish Remove Layer должен 

выглядеть таким образом: 

 
 
Иногда у вас возникает желание остановится на этом шаге. Levels 

откорректированы, пятнышки убраны – может это и все, что нужно вашей 
фотографии. Вы можете объединить ваши слои и закончить работу.  

Если вы перестарались с коррекцией, вы можете отрегулировать 
ползунок opacity в Layers Palette, чтобы уменьшить эффект и слегка вернутся 
к оригиналу. Сольно вы будете корректировать фото или нет – это на ваше 
усмотрение. Вы также можете использовать маску, но об этом чуть позже.  

Мы получили хорошую основу для дальнейшей работы. Что нам еще 
нужно …. Безупречную кожу. 

Шаг 3. Безупречная кожа.  
На изображениях, которые мы получаем после ретуши, часто есть 

цветные пятнышки на коже, неровности или резкие переходы, которые 
нуждаются в сглаживании. В прошлом вы должны были бы корректировать 
каналы, использовать фильтр gaussian blur или работать кистью, что бы 
сгладить эти погрешности. Теперь в новом Photoshop CS2 есть фильтр 
Surface Blur.  
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Surface Blur Filter может дат вам великолепную базу для макияжа. 
Фильтр исследует пиксели со всего лица и аккуратно смешивает их вместе, 
что дает чудный результат и совершенно гладкую кожу. Все прекрасно 
выглядящие модели сегодня имеют одну общую особенность – в основе 
безупречный макияж. Без него будет проблематично создать новый вид.  

С новым фильтром CS2 Surface Blur мы сможем добиться всех этих 
улучшений за минуту. Главное здесь – понять, каким образом выбрать 
правильные значения и как не перестараться. Этот фильтр хорош для работы 
с портретами, фотографиями хрома и металла и со всякими фото, где есть 
большие гладкие поверхности. 

Итак, создаем новый слой с нашим портретом, содержащий все 
внесенные исправления. Лучше создать два идентичных слоя для максимума 
контроля. Один слой – это картинка со всеми изменениями. Он станет новой 
основой для нашей коррекции. Ко второму слою мы применим эффект 
Surface Blur. 

Существует короткий способ как это сделать. Нам нужно копировать все 
активные нижние слои и сделать новый композитный слой. Но, без удаления 
всех предыдущих слоев! Так же как мы делаем snapshot слой. И не удаляйте, 
не объединяйте какие-либо слои в процессе! Мы должны быть уверены, что в 
случае необходимости сможем использовать уже существующие слои.  

Маленький трюк! Удерживайте на PC одновременно клавиши Shift, Ctrl 
и Alt и затем нажмите клавиши N и E. Вы получите объединенную копию 
всех активных слоев и одновременно оставите все слои нетронутыми.  

Сделайте два композитных слоя. Первый слой назовите "композит 
слой". Второй назовите "Surface Blur", поскольку на нем мы и будем 
применять фильтр. Порядок слоев посмотрите на рисунке ниже. 
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(рис. Нажмите Shift+Ctrl+Alt+N ,чтобы создать новый слой. 
Продолжайте удерживать Shift+Ctrl+Alt+Е для создания копии всех нижних 
слоев и расположения их на новом слое) 

Выберите верхний слой и примените фильтр Filter>Blur>Surface Blur. 
 

 

 
Фильтр исследует всю поверхность лица и интегрирует цвета , чтобы 

получить смешанный цветовой слой, который вы можете смешать с 
оригиналом для получения более реалистичной картинки. Позже мы добавим 
маску слоя для более полного контроля за результатом. 

Важно правильно применять данный фильтр для получения нашего 
результата. Нужно установить значения радиуса и threshold так , чтобы в 
результате мы получили мягкий и гладкий тон кожи. Вы можете выбрать 
большее или меньшее значение , это на ваш вкус. На рисунках ниже можете 
посмотреть, что может получиться. 
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(рис. Кожа еще не совсем гладкая. Недостаточная степень применения 

фильтра) 
 

 
(рис. Фото стало как в тумане. Слишком много фильтра) 
 

 
(рис. Кожа достаточно гладкая. Правильно применили фильтр) 
Ориентируйтесь на последний рисунок – это и есть результат 

правильного применения фильтра. Гладкая кожа и тонкий теневой переход от 
светов к теням. Передвигая ползунки, вы можете получить широкий 
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диапазон тонов. Желательно отслеживать темные тона на щеках, чтобы не 
потерять их для наших дальнейших манипуляций. 

На данном этапе мы получили слишком сильный эффект. Для его 
смягчения мы применим технику, позволяющую контролировать силу 
применения эффекта. Мы добавим теней и затем добавим текстуры кожи для 
более естественного вида модели. 

Итак, у нас прекрасное изображение, без изъянов, с отличным макияжем 
и безупречной кожей. Скорее слишком совершенное! Позже мы смягчим 
эффект. 

А сейчас очень важный момент!!! Создание маски для ретуши, которая 
позволит нам применить какой-либо эффект с большой точностью и 
возможностью восстановления. 

Специальная техника – маска слоя – маска для ретуши. 
По моему мнению, это очень важный момент в ретуши. Если вы освоите 

эту технику, то это позволит вам вносить любой вид коррекции и 
контролировать его применение, силу и точность. С практикой вы сможете 
рисовать поверх цветовой коррекции, текстур, светов, волос, губ, поверх 
контрастных изменений, на ресницах или даже на драгоценностях вашей 
модели не оставляя следов.  

Основная концепция: техника, которую я использую здесь называется 
"black mask" или техника скрывающей маски. Она включает один или два 
слоя и позволяет рисовать по верхнему слою или смешивать его с нижним с 
большой мягкостью и точностью.  

Обычно, если у вас есть нижний слой,  вы располагаете еще слой над 
ним, верхний слой перекрывает нижний. Что мы будем делать, чтобы 
изменить такое положение вещей? Мы просто добавим маску для верхнего 
слоя. Маска перекроет верхнее изображение на короткое время, там, где мы 
начнем рисовать белой кистью, изображение снова будет проявляться. Итак, 
если у вас есть текстура, размытие или оттенок на верхнем слое – вы можете 
взять мягкую белую кисть с низкой степенью opacity и рисовать, внося 
коррективы в нижний слой на том месте, где вам это необходимо. Это 
позволит вам контролировать весь процесс внесения корректив. 

Еще одна хитрость данного метода – если вам не понравился результат 
коррекции, просто измените цвет кисти на черный и сотрите ненужную 
коррекцию. Итак, белая кисть вносит изменения в рисунок, а черная – 
скрывает их. Даже если вы используете мягкую кисть с низкой степенью 
opacity (от 14% до 30%) вы заметите явные и резкие коррекционные линии. И 
только с практикой ваша ретушь будет выглядеть гладкой и незаметной.  

После того как вы создали два идентичных слоя (хотя это не 
обязательно, но я настаиваю на этом), добавьте маску слоя для ретуши на 
верхний слой (в нашем случае это слой surface blur). Пусть это будет эффект 
surface blur, выборочное придание резкости или цветовая коррекция – это не 
важно. Вы получили достаточно сильный эффект от применения фильтра к 
верхнему слою, начните выборочно рисовать на маске, как в следующем 
шаге. 
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(рис. Наверху – слой с фильтром и черной маской слоя.) 
Для того чтобы создать маску нажмите Layer>Layer Mask>Hide All. 

 
Так же вы можете использовать более короткий путь – нажать значок 

внизу палитры слоев. Если вы хотите получить специальную маску черного 
цвета, удерживайте клавишу Alt (Option) при нажатии иконки маски. Рядом с 
иконкой слоя должно появиться окошко черного цвета – это и есть наша 
маска. Для того чтобы начать работать с маской, кликните по иконке маски. 

Маска должна быть выделена, затем выберите белую кисть и уменьшите 
opacity с 6% до 14% или 30% (на ваш выбор). Затем рисовать на слое. 
Постепенно должно начать проявляться размытие. Пройдитесь несколько раз 
кистью по необходимой вам области, что бы усилить эффект. Обработайте 
щеки и лоб. Не усердствуйте в тех местах, где были морщины, иначе можете 
вернуть их обратно! Все это на ваше усмотрение. 
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После обработки маски слоя ваше изображение должно выглядеть 

примерно так. Область закрашенная белым цветом – это то, что вы 
обработали и сильно проявили эффект. Серая область – средняя степень 
обработки фото. Черная область – там, где фото осталось оригинальным, без 
обработки. 

 
Шаг 4. Добавление легких световых пятен и мягких теней. 
Внешний вид гламурных моделей в журналах имеет характерную 

гладкую кожу, но также – резкие светлые, темные и другие оттенки. Сейчас 
мы добавим очень мягкие и нежные светлые пятна и слегка сексуальные 
тени. 

Есть два способа как это сделать. 
Первый способ – создать новый слой, залить его 50% серым цветом , 

сменить режим смешивания на Overlay и рисовать белой и черной кистью с 
низкой степенью opacity. Это превосходная техника может быть 
использована после всех основных действий по ретуши. Обычно она 
используется, когда нужно вместе откорректировать яркость и темные 
участки изображения. Прелесть этой техники в том, что вы можете всегда 
исправить результат коррекции. Для этого мы создадим два дополнительных 
слоя. Один будет использован для мягкого затемнения, другой – для 
осветления.  
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Создание светлых бликов.  
Обычно сначала я делаю коррекционный слой для бликов. Это придает 

портрету восхитительное освещение и так как этот эффект расположен на 
отдельном самостоятельном слое, то его можно редактировать.  

Итак, добавьте два прозрачных слоя поверх уже существующих. 
Назовите один слой «Highlights», а другой «Shadows». Если есть 
необходимость можете сделать композитный слой ( Shift,Ctrl,Alt N и E).  

Начните работать жесткой кистью, обязательно белой. Смените режим 
смешивания слоя на "soft light". Обычно я добавляю несколько белых 
штрихов ниже глаз, по центру носа, на лбу и на подбородке. 

 
Вы можете видеть на рисунке применение эффекта во всей силе. 

Примените к слою фильтр Gaussian Blur ,что бы размыть границы светлых 
пятен. Это один из приемов добиться гладкой кожи. Отрегулируйте значение 
фильтра по вашему усмотрению. 

   
(рис. Слева направо – мало применен фильтр Gaussian Blur , достаточно, 

слишком много) 
Итак, наша цель – размыть резкие белые пятна, что бы получить 

шелковый блеск. Сначала отредактируйте слой со светлыми пятнами, затем 
вы можете подкорректировать интенсивность светов, регулируя opacity слоя. 
Но не перестарайтесь, так слишком светлые блики будут слишком 
отвлекающими. Световые блики дадут нам ощущение внутреннего свечения. 

 Вы также можете рисовать этими светлыми пятнами везде, где вам 
необходимо подчеркнуть форму, например, на руках, ногах или челюсти. Но 
это все на ваше усмотрение. Мягкие, светлые блики вместе с тенями, которые 
мы создадим в следующем шаге, придадут сексуальности, драматизма, 
контрастности и слегка скульптурный вид. Таким образом, у вас будет 
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полный контроль за всеми областями со светлыми бликами. Сохраняйте эти 
слои отдельно и называйте их таким образом, что бы позже вы могли 
свободно играть этими слоями, смешивать их различным образом. 

Создание теней.  
На этом шаге мы будем создавать ровные тени для нашего изображения. 

Еще одной характерной чертой гламурного портрета являются ровные тени. 
Мы и будем рисовать область теней точно так же, как мы создавали светлые 
блики. 

Сначала мы создадим новый прозрачный слой над оригиналом 
изображения и назовем его "shadow". Режим смешивания установите "soft 
light". 

А теперь приступим к рисованию теней. Возьмите жесткую кисть, 
среднего размера с 100% opacity и начните рисовать на щеках, в местах, где 
обычно наноситься румянец. Итак , мы имеем два четких , кошмарно 
выглядящих черных или коричневых пятна на щеках. Сейчас откройте 
фильтр Gaussian Blur и откорректируйте слой таким образом , чтобы эти 
кошмарные пятна стали гладкими и ровными.  

Вы можете оставить тени более жесткими, если у вас есть 
необходимость сделать макияж более сильным. Регулируйте opacity слоя, 
чтобы откорректировать интенсивность теней. 15 – 30 % opacity обычно 
достаточно. Насколько темными будут ваши тени – это на ваш вкус.  

 
 
(рис. Нарисуйте на новом слое темные пятна на щеках, затем смените 

режим смешивания на Soft Light). 
Посмотрите на рисунки, где показаны три степени – «слишком много, 

норма, недостаточно». В случае с тенями применение фильтра Gaussian Blur 
не дает все-таки нужного нам мягкого результата. Поэтому мы и регулируем 
opacity слоя. Но это все на ваш художественный вкус. 
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(рис. Слева направо – фильтр Gaussian Blur применен мало, достаточно, 

слишком много) 
Находите баланс между сильной степенью применения эффекта и его 

мягкостью. Если вы используете различные слои, у вас есть возможность 
смягчать их и смешивать с другими слоями.  

Иногда вам нужно будет обработать и другие области. Это зависит от 
вашего изображения. Создайте отдельный слой для каждого эффекта, 
назовите его соответствующим образом и у вас будет полный контроль над 
вашим результатом. 

Добавьте тени на область носа, подбородка, тени под глазами, чтобы эти 
области  не выглядели плоскими. 

Итак, повторяем - чтобы создать тени нам нужно нарисовать темную 
область, затем размыть, поменять режим смешивания и отрегулировать 
opacity слоя. Другие различные области, нуждающиеся в наложении мягких 
тонов – это переносица, линия подбородка, глазницы, область лба.  

Также эта методика хороша для ретуши области плеч, рук и ног, чтобы 
придать этим областям красивую округлость тела и гламурный тон. Если вы 
обладаете художественными навыками и имеете терпение, вы можете создать 
большое количество таких свето-теневых областей. Вы можете передвигать, 
менять масштаб и выборочно стирать часть этих слоев. Особенно я люблю 
использовать эти слои снова после окончательной обработки изображения. 
Так как режим смешивания для слоев установлен soft light, то они прекрасно 
сочетаются, где бы эти слои не располагались. 

Дополнительно можно взять эти свето-теневые слои и использовать 
hue/saturation/brightness для коррекции цвета. Итак, у нас есть ретушь 
недостатков кожи, с возможностью ее коррекции, ровная, гладкая кожа, тени, 
светлые блики на ваш вкус. Некоторые любят более натуральный вид, 
некоторым нравится более гламурный. Все – на ваш выбор! 

Сейчас нам нужно добавить чуть текстуры или шума в изображение, что 
бы добавить реализма.  

Шаг 5. добавление текстуры для придания реализма изображению. 
Еще один характерный элемент для журналов, кроме гладкости и 

ровности кожи, это отличная текстура кожи и поры. Что и говорить, модель, 
прекрасно освещенная при фотосессии, покрытая достаточным слоем 
макияжа, проводит не один час для достижения такого шикарного 
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результата. Но, не будьте наивными – никто не обладает такой совершенной 
кожей (если только детки ). Именно поэтому все они и нуждаются в нас, 
невоспетых героях – мастерах ретуши! Это прекрасно иметь отличный 
оригинал для работы, но большинство из нас, простых людей с самыми 
обычными фотографиями! 

Действия, которые дадут нам возможность вернуть текстуру кожи и 
поры (после предыдущей обработки): 

- вы можете смешать отретушированное изображение с оригиналом и 
дать возможность проявиться морщинкам и текстуре; 

- вы можете создать текстурную маску, используя собственную 
оригинальную кожу модели и выборочно рисовать этой текстурой по 
изображению; 

- вы можете взять из другого изображения и создать шаблон 
превосходной кожи с порами и затем применить эту текстуру к 
изображению, с которым работаете; 

- вы можете приобрести полный набор текстур кож с 3D сайта; 
- вы можете использовать любой из 7 фильтров (noise, grain, или texture), 

что бы придать гламурный или художественный вид вашему изображению. 
Итак, возвращаем оригинальную текстуру кожи. Я добавляю здесь 

короткий раздел, поясняющий как нам вернуть оригинальную текстуру в 
обработанное изображение. Ранее мы создали несколько слоев – 
корректирующий яркость, ретушь пятен, придание кожи эффекта гладкости и 
затем вернули свето-теневые переходы. В итоге наше изображение выглядит 
просто превосходно, но некоторые люди хотят получить как бы 
неотретушированное изображение, очень естественно выглядящее. 
Запомните - ретушь должна быть незаметной!!! 

У нас есть один простой выход – смешать оригинал с обработанным 
изображением, используя настройку opacity слоя. Каким образом мы это 
сделаем? Расположите отретушированное изображение поверх оригинала. 
Затем, используя ползунок opacity слоя сделайте обработанное изображение 
слегка прозрачным. Оригинал со всеми морщинками начнет просвечивать 
сквозь слой, в этот момент вы получите смесь отретушированного 
изображения и оригинала. Выберите, какой степени реализма вы хотите 
добиться. Это достаточно просто.  
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Приступим к следующему уровню. Есть один, действительно, 
превосходный способ вернуть текстуру кожи лица – это использование маски 
для проявления части обработанного изображения именно в тех местах, где 
для этого есть необходимость. Вы можете обработать щеки и область лба 
более сильно, но вам придется оставить мимические морщинки в области рта 
и глаз. Для большего реализма! Для этого нам не обязательно явно 
прорисовывать все морщины. Иногда достаточно 1/2 или 1/3 степени 
интенсивности, чтобы получить мягкий естественный вид морщинок. 
Однако, должна сказать, что не все фотографии обрабатываются подобным 
образом. Например, фото пожилых людей нуждаются в более характерных 
линиях и в сохранении большего количества морщин, чем двадцатилетние 
девушки и юноши. 

Другие эффекты создаваемые при помощи собственных текстур 
Photoshop и фильтра Grain. 

Итак, у вас есть фото, которым вы уже довольны. Но вы можете 
добавить зернистости, текстуры или других эффектор программы Photoshop 
для значительного улучшения внешнего вида модели. В программе нет 
именно текстуры пор кожи, но есть другие фильтры – шум, зернистость. 
Именно их применение вы часто и можете наблюдать в современных 
глянцевых журналах. Здесь мы рассмотрим 7 типов текстур, которые 
используются наиболее часто. 

• Фильтр noise. Фильтр находится в меню Filter> Noise> Add Noise. 
Внимательно смотрите на превью, где виден результат применения фильтра. 
Лучше применять монохромный шум, а не цветной. Однако, это на ваше 
усмотрение. Добавьте шум в ваше изображение ,можно даже усилить эффект, 
т.к. позже вы можете отрегулировать степень интенсивности с помощью 
opacity или маски. Такой эффект очень популярен и вы можете увидеть его 
почти во всех модных публикациях. 

Прежде всего создайте композитный слой и расположите его наверху. 
Затем сделайте дубликат слоя. Вы можете сделать тест на верхнем 
изображении и затем используя маску ретуши выборочно проявить шум. 
Возьмите для этого кисть где-то 15% opacity. Дайте резкости верхнему 
изображению, затем проявите этот эффект только под глазами. Это их 
выделит. Почему придавая резкость всему изображению мы только 
проявляем его у глаз, можете этого не делать. Расположите ваш оригинал 
внизу палитры слоев, а откорректированное изображение наверх. Затем 
начните рисовать сквозь нижнее изображение, используя белую маску и 
белое перо.  

Используя подобную технику двух слоев (с применением маски для 
контроля за результатом) вы добьетесь наиболее креативных и 
художественных результатов.  

•Conte Crayon texture. Находится в Menu> Filter> Sketch> Conte Crayon. 
Применение этого эффекта даст вам черно-белую карту, которую вы можете 
корректировать много раз. Обычно здесь применяется режим смешивания 
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soft light. Текстура sandstone очень хороша для этого. Впрочем, подходит и 
canvas, но это для придания более художественного, картинного вида. 

• Film Grain. Находится в Menu> Filter> Artistic> Film Grain. Вполне 
понятно какой эффект можно достичь, применяя его. Иногда эффект 
зернистости старых фильмов придает очарование изображению. Очень 
естественный и популярный эффект.  

• Reticulation. Находится в Menu> Filter> Sketch> Reticulation. 
Получается эффект как будто вы передержали пленку в проявителе при 
большой температуре. Пленка становится зернистой.  

•Diffuse Glow. Находится в Menu> Filter> Distort> Diffuse Glow. Фильтр 
очень хорош, но не совсем подходит для создания текстур кожи. Он 
добавляет прекрасный рассеянный свет в изображение, что придает ему 
совершенно другой вид. Попробуйте применить этот фильтр вместо 
наложения белых световых бликов (что мы делали выше). Фильтр берет 
естественные яркие точки с лица и добавляет свечение точно на эти точки. 
Вы можете отредактировать и добавить мягкий блеск, сделать модель 
сверкающей и светящейся изнутри. Примерно это будет выглядеть как будто 
фото сделано в стиле High Key. 

 

     
Оригинал       Ретушь без текстуры и зерна          Ретушь+Оригинальная 

текстура 
Лабораторная работа 3 
Создание фото-рамки: 

Вот как будет выглядеть итоговый результат: 
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Рамка со снежинками 
Шаг 1: Создадим новый документ Photoshop 
 В Photoshop есть готовая кисть со снежинками, можно было бы 

воспользоваться ей, но она слишком маленькая, и если ее сильно увеличить, 
эффект будет слишком уж размытый и невыразительный. Раз уж мы хотим, 
чтобы все было четко и красиво, мы сделаем собственную кисть со 
снежинками с помощью встроенных произвольных фигур Photoshop. 
В первую очередь нам понадобится документ, в котором мы будем создавать 
эту кисть, так что в меню в верхней части экрана откройте File и выберите 
New: 

 Нажимаем File > New 
Откроется диалоговое окно New Document, предназначенное для 

создания нового документа. Задайте значения Width (Ширина) и Height 
(Высота) по 200 пикселей, а в опции Background Contents выберите White, 
после чего закройте диалоговое окно, нажав OK. Перед вами появится новый 
документ 200×200 пикселей залитый белым цветом: 

 Убедитесь, что задаете размеры 
документа именно в пикселях, а не дюймах и т.д.  

Шаг 2: Выбираем инструмент Custom Shape 
В панели инструментов выбираем Custom Shape Tool. По умолчанию он 

находится за инструментом Rectangle Tool, так что нажмите на него и 
удерживайте кнопку мыши до появления выпадающего меню, а потом в 
списке найдите Custom Shape Tool. 

 Выбираем инструмент Custom Shape Tool  
Шаг 3: Загружаем набор фигур Nature 
В Photoshop есть не только кисть со снежинками, но и несколько 

готовых снежинок в наборе готовых фигур, и вы можете выбрать 
понравившуюся. Надо лишь загрузить этот набор. Выбрав инструмент 
Custom Shape Tool, при помощи щелчка правой кнопки мыши (Win) / щелчка 
с удержанием Control (Mac) в любой точке нового документа мы можем 

69 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



открыть панель с фигурами, после чего надо нажать на стрелочку в правом 
верхнем углу: 

 Нажимаем на треугольничек в правом 
верхнем углу панели с фигурами 

 После нажатия на стрелочку появляется меню с многочисленными 
дополнительными наборами фигур, которые можно загрузить. Нам нужен 
набор Nature. Выберите его: 

 Находим в меню набор фигур Nature 
Photoshop спросит, следует ли заменить имеющийся набор фигур новым 

либо просто добавить его ниже. Нажимаем Append: 

 Выбираем Append, чтобы добавить набор 
фигур Nature к уже имеющимся  

Шаг 4: Выбираем снежинку  
Найдите снежинки (их три прямо друг за другом). Если у вас в меню 

Preferences активирована опция Tool Tips, то при наведении мыши на каждую 
фигуру будет всплывать ее название. Для рамки нам понадобится всего одна 
снежинка, так что выберите ту, которая нравится вам больше всего, для чего 
щелкните по миниатюре мышью, а потом закройте панель с фигурами, нажав 
Enter (Win) / Return (Mac). Выберем самую первую (левую) снежинку. 

 Возьмите любую из трех снежинок, 
щелкнув по ее миниатюре 

Шаг 5: Выбираем опцию Fill Pixels 
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Photoshop позволяет работать с тремя типами фигур – векторными 
фигурами, контурами и фигурами на основе пикселей. Мы можем 
переключаться между этими тремя вариантами в панели опций. Поскольку 
мы будем делать из снежинки кисть, а кисти состоят из пикселей, то мы 
будем пользоваться фигурой на основе пикселей. Так что нажимаем на 
иконку Fill Pixels в панели опций (правая) 

: 
 Перед вами три иконки, каждая из них соответствует своему типу 

фигур. Иконка “Fill Pixels” - самая правая 
 Шаг 6: Растягиваем снежинку 
Убедитесь, что в качестве цвета переднего плана задан черный, для чего 

нажмите клавишу D на клавиатуре, и Photoshop восстановит цвета переднего 
и заднего плана по умолчанию (передний план - черный). Затем щелкните 
внутри документа в районе верхнего левого угла и, удерживая Shift, 
начинайте растягивать снежинку. Благодаря клавише Shift будут сохраняться 
ее пропорции. Если вы хотите сместить фигуру, нажмите пробел и сдвиньте 
ее с помощью мыши, после чего можно отпустить пробел и продолжить 
растягивать снежинку: 

 Черная фигура станет кистью. А белое будет 
оставаться прозрачным 

Шаг 7: Делаем из фигуры кисть  
В верхней части экрана найдите меню Edit, в нем выберите Define Brush 

Preset:  

Открываем Edit > Define Brush Preset  
Когда появится диалоговое окно Brush Name, дадим нашей кисти 

название - “Snowflake” («Снежинка»), а потом закроем его, нажав ОК. Теперь 
можно закрыть и документ со снежинкой, он нам уже не нужен (если 
Photoshop предложит сохранить его, делать это не обязательно): 
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 Назовем новую кисть 
“Snowflake”  

Шаг 8: Открываем фотографию 
Подготовив кисть со снежинкой, открываем снимок, на котором будем 

делать рамку. Мы будем использовать этот кадр: 

 Оригинальный снимок  
Шаг 9: Добавим чистый слой 
Нажмите на иконку New Layer, расположенную в нижней части панели 

слоев, чтобы добавить новый слой над существующим. Photoshop назовет его 
"Layer 1". 

 Над оригинальным слоем 
Background добавляется новый чистый слой "Layer 1" 

 Шаг 10: Заливка нового слоя белым цветом  
В меню Edit в верхней части экрана выберите Fill: 

 Открываем Edit > Fill 
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Откроется диалоговое окно Fill. В опции Use выберем White и нажмем 
OK, после чего диалоговое окно закроется: Теперь документ стал 

белым:  
 

Поставьте в опции Use цвет White (белый) и нажмите OК 
  
Шаг 11: Выбираем участок, куда вставить фотографию 
  
В меню Select выберите All. Таким образом вы выделили весь документ, 

контур выделения проходит по границе кадра: 

  
 

Выбираем Select > All 
  
Теперь возвращаемся в меню Select и на этот раз выбираем Transform 

Selection: 

 Нажимаем Select > Transform Selection  
Команда Transform Selection позволяет нам изменить размер или форму 

выделения, при этом то, что находится в его рамках, не меняется. Нажимаем 
на верхний манипулятор (квадратик), и, удерживая Alt (Win) / Option (Mac), 
смещаем его немного к центру, чтобы между контуром выделения и 
границей документа остался 1-1,5 см. Если вы удерживаете Alt / Option, то 
вся зона выделения будет сдвигаться относительно центра, то есть, нижний 
манипулятор тоже будет перемещаться. Затем повторите процедуру с левым 
манипулятором - удерживая Alt (Win) / Option (Mac) сдвигайте его к центру, 
оставив такое же расстояние между контуром выделения и границей 
документа. Правый манипулятор тоже сместится пропорционально левому. 
Закончив, нажмите Enter (Win) / Return (Mac), чтобы принять изменения: 
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 Удерживая Alt смещаем верхний и левый 
манипуляторы к центру 

Шаг 12: Удаляем содержимое зоны выделения 
Чтобы удалить все то, что находится в рамках зоны выделения, нажмите 

Backspace (Win) / Delete (Mac), после чего проступит лежащая под этим 
слоем фотография. Контур выделения остается активным: 

 Удаляем все, что находится в зоне 
выделения, оставляя ее контур активным  

Шаг 13: Расширяем выделение 
Теперь нам надо расширить контур выделения. Можно снова 

воспользоваться командой Transform Selection, но есть способ еще проще. 
Возвращаемся в меню Select, выбираем Modify, затем Expand: 

 Открываем Select > 
Modify > Expand  

Когда появится диалоговое окно Expand Selection, вводим значение 
около 20 пикселей и нажимаем ОК. 

 Увеличиваем выделение примерно 
на 20 пикселей 

Рамка выделения сдвинется на 20 пикселей от центра. Обратите 
внимание, что углы рамки выделения из острых стали закругленными. В 
этом заключается недостаток команды Expand Selection, из-за которого она 
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не всегда является идеальным инструментом для увеличения зоны 
выделения, но для нашего спецэффекта закругленные углы - не проблема: 

 Все границы выделения сдвинулись на 
20 пикселей от центра 

 Шаг 14: Применяем фильтр Gaussian Blur  
Теперь нам надо смягчить границу фото-рамки, сделав переход между 

белым краем и изображением мягче. Для этого мы размоем рамку. В верхней 
части экрана откройте меню Filter, в нем выберите Blur, затем Gaussian Blur: 

 Откройте Filter > Blur > Gaussian 
Blur 

Когда появится диалоговое окно Gaussian Blur, увеличьте значение 
Radius примерно на 8 пикселей, край рамки размоется, став мягким и 
красивым. Нажав ОК, закройте диалоговое окно. 

 Увеличиваем Radius на 8 пикселей и нажимаем 
ОК 

Переход стал мягче. Контур выделения оставляем, он нам еще 
понадобится. По нему мы будем наносить снежинки: 

 Граница стала мягче 
Шаг 15: Выбираем инструмент Brush Tool 
Выбираем Brush Tool в панели инструментов. 

75 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 Выбираем инструмент Brush Tool  
Шаг 16: Выбираем кисть-снежинку 
Выбрав инструмент Brush Tool, при помощи щелчка правой кнопки 

мыши (Win) / щелчка с удержанием Control (Mac) в любой точке документа 
мы можем открыть панель с кистями, в которой находим только что 
созданную кисть-снежинку. Она должна оказаться последней в списке. 
Выбираем ее и закрываем панель с кистями, нажав Enter (Win) / Return (Mac). 

 Щелкаем по миниатюре кисти-снежинки и 
нажимаем Enter (Win)   

Шаг 17: Задаем динамические опции кисти  
Чтобы быстро открыть полную панель кистей Photoshop, нажимаем F5, 

после чего в левом столбце выбираем Shape Dynamics. Щелкайте прямо по 
словам, а не в клеточке перед ними, иначе вы активируете динамические 
опции, не задав их. 

 Щелкаем по словам “Shape Dynamics”, которые 
находятся в левом столбце панели кистей 

  
Выбрав Shape Dynamics, задаем в опциях Size Jitter и Angle Jitter 100%, 

сделав размер и угол поворота снежинок совершенно непредсказуемым: 

76 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 В опциях Size Jitter и Angle Jitter задаем 
значение 100% 

Сделав это, щелкните по слову Scattering, которое также находится в 
левом столбце панели кистей, и увеличьте значение Scatter примерно до 
250%, благодаря чему снежинки будут сыпаться хаотично, а не по прямой 
линии. Закончив, нажмите F5, чтобы закрыть панель кистей. 

Щелкаем по опции 
Scattering и задаем значение Scatter около 250%  

Шаг 18: Делаем из рамки выделения контур  
Откроем панель контуров, которая находится там же, где и панели слоев 

и каналов (чтобы активировать панель, щелкните по ее названию). Затем 
нажмите на иконку Make Work Path From Selection, которая находится в 
нижней части панели контуров: 

 Щелкаем по иконке Make Work Path From 
Selection 

Photoshop сделает из выделения контур, и в панели слоев появится 
контур Work Path. Это название означает, что он временный. Мы можем его 
сохранить, но в этом нет необходимости: 
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 В Photoshop временные контуры 
получают название “Work Path”  

В окне документа мы увидим, что вместо рамки выделения появилась 
тонкая сплошная линия - это и есть наш контур: 

 Появившаяся тонкая линия - 
это контур, по которому будут рассыпаны снежинки  

Шаг 19: Выбираем белый в качестве цвета переднего плана и уменьшаем 
размер кисти 

Чтобы обратить цвета переднего и заднего плана, установленные в 
Photoshop по умолчанию, нажмите кнопку X, и тогда передний план станет 
белым (это нужно потому, что Photoshop рисует тем цветом, который задан 
как цвет переднего плана). Затем при помощи щелчка правой кнопки мыши 
(Win) / щелчка с удержанием Control (Mac) в любой точке документа снова 
откроем панель с кистями и уменьшим размер кисти примерно до 50 
пикселей, поскольку размер кисти по умолчанию слишком велик для нашей 
рамки. Закончив, нажмите Enter (Win) / Return (Mac), и панель кистей 
закроется: 
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 Сдвигаем ползунок Size влево, 
уменьшая размер кисти 

Шаг 20: Проводим кистью-снежинкой по нарисованному контуру  
И, наконец, нажимаем на иконку Stroke Path With Brush, которая 

находится в нижней части панели контуров:  

Щелкаем по иконке Stroke Path With 
Brush - она вторая слева 

  
По контуру появляются первые 

снежинки:  
 

По контуру под разным углом рассыпаются первые снежинки разных 
размеров 

  
Возможно, вы поймете, что ошиблись с размером кисти. В таком случае 

можно отменить сделанное, нажав Ctrl+Z (Win) / Command+Z (Mac), после 
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чего изменить размер кисти с помощью правой или левой скобки на 
клавиатуре. Левая скобка ( [ ) уменьшает размер кисти, а правая ( ] ) - 
увеличивает. Отрегулировав размер кисти, снова нажмите на иконку Stroke 
Path With Brush. Возможно, придется менять размер кисти несколько раз, 
прежде чем получится то, что нужно. 

Когда будете довольны размером, еще несколько раз щелкните по 
иконке Stroke Path With Brush, чтобы снежинок стало еще больше. Когда 
будет достаточно, щелкните в любой точке серого пространства под Work 
Path в панели контуров, чтобы убрать контур из окна документа: 

 Щелкаем в пустом месте панели 
контуров, чтобы отключить контур 

 Обратите внимание на то, что теперь опция Stroke Path With Brush стала 
неактивной. Если вам захочется добавить еще снежинок, сначала придется 
вернуть контур, для чего необходимо щелкнуть по миниатюре Work Path в 
панели контуров: 

  

 
Снова активизируем контур, щелкнув по его миниатюре. Обводить 

контур можно лишь когда он виден 
  
Я добавляла снежинки, щелкнув по иконке Stroke Path With Brush три 

раза, и теперь доволен спецэффектом. 
 Источник - photoshopessentials.com 
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Лабораторная работа 4 
 

Делаем коллаж в Фотошоп 
В этом уроке мы научимся создавать красивую абстрактную работу, 

используя всего лишь 3 изображения. Комбинирование изображений, при 
создании работ в программе Adobe Photoshop, очень часто приносит очень 
хорошие результаты. 

Самой тяжёлой частью данного урока будет совмещение упавшей капли 
воды с небом. Автор советует использовать фоновое изображение, на 
котором небо очень чистое, либо с разбросанными облаками для более 
реалистичного эффекта. Знание режимов наложения и умение применять их 
на практике, сэкономит вам значительное количество времени и 
предотвратит множество ошибок. Автор использовал режим наложения 
Multiply (Умножение) для капель воды, а также корректирующий слой Levels 
(Уровни) для осветления средних тонов. 

Шаг 1 
Давайте откроем изображение с городом (Ctrl+O) в программе Adobe 

Photoshop либо просто перенесите это изображение в программу.Тут же 
создадим новый корректирующий слой Exposure (Экспозиция) и применим 
такие же настройки, как на скриншоте. Т. о, мы сделаем изображение ярче. 

 
Шаг 2 
Откроем изображение с каплей воды (Ctrl+O) либо также, можно 

перенести изображение в программму, а затем уже в документ, 
предварительно выделив его (Ctrl+A), а затем, при помощи инструмента 

Move (Перемещение) (V), либо с зажатой клавишей Ctrl перенесите 
изображение в наш документ. При помощи инструмента Free Transform 
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(Свободное трансформирование) (Ctrl+T) давайте отразим изображение с 
каплей воды по вертикали, нажав правую кнопку мыши и выбрав Flip to 
Vertical (Отразить по вертикали). Далее, расположите изображение с каплей 
как на скриншоте: 

 
Примечание переводчика: для того, чтобы изображение увеличивалось/ 

уменьшалось из центра, нужно держать зажатой комбинацию клавиш 
Shift+Alt. 

Шаг 3 
Переведите слой с каплей в режим Smart Object (правый клик на слое - 

Convert to Smart Object). При помощи комбинации клавиш (Ctrl+L), которая 
вызывает команду Levels (Уровни) давайте слегка осветлим изображение 
(сдвинем средний ползунок до значения 2,55).Создайте обтравочную маску 
Соайт()е  
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Результат: 

 
Примечание переводчика: обратите внимание, что под слоем с каплей 

появилась команда Levels (Уровни), которую мы только что использовали. 
Т.о, если мы захотим внести правки, можно просто дважды кликнуть на 
надписи Levels (Уровни) и окно редактирования появится снова. 

Шаг 4 

Далее, давайте создадим белую Layer Mask (Маску слоя) для слоя с 

каплей и воспользуемся инструментом Gradient (Градиент) (G) от 
чёрного к белому. Протянем, этим инструментом, сверху вниз, как указано на 
скриншоте. 
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Результат:  
Шаг 5 
Воспользуемся инструментом Brush (Кисть) (B) чёрного цвета с Opacity 

(Непрозрачностью) 50% и пройдёмся этим инструментом по краям 
изображения с каплей, чтобы получилось как на скриншоте. 

 
Шаг 6 
Далее, нам нужно слегка осветлить изображение с каплей, чтобы можно 

было как можно лучше удалить чёрную область на этом изображении. 
Сначала, автор предлагает воспользоваться Layer Style (Стилями слоя), а 
конкретнее, ползунками Blend if (Наложить, если) в общем разделе Blending 
Options (Параметры наложения), которые указаны на скриншоте: 

 
Примечание переводчика: если вы обратите внимание на эти ползунки, 

то вы увидите, что каждый из них разделён на две половины, которые 
тоже можно регулировать. Автор пробует двигать правую половину левого 
ползунка. Замечу, что для того, чтобы двигать одну из двух половин, нужно 
нажать и удерживать клавишу Alt. 

Становится заметно, что чёрная область начинает исчезать, но края 
выделенной области слишком резкие, а также этот способ удаления плохо 
сказывается на капле, которая замерла на изображении. Что нас не 
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устраивает! Давайте попробуем воспользоваться альтернативным способом 
удаления чёрной области. Дважды кликнем на Levels (Уровни), которые 
находятся под слоем Smart Object и сдвинем левый нижний ползунок, 
находящийся в чёрной области, вправо, до значения 55. 

 
И вот результат: 

Шаг 7 
Теперь, приближая чёрную область мы увидим, что она уже не такая 

чёрная. Теперь можно снова попробовать удалить эту чёрную область с 
помощью ползунков Blend if (Наложить если) в разделе Blending Options 
(Параметры наложения). Установим такие же значения ползунков, как на 
скриншоте и изменим режим наложения на Multiply (Умножение). 
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И вот наш получившийся результат: 

 

По окончанию, снова воспользуйтесь инструментом Brush (Кисть) 

(B) для удаления лишних фоновых участков на Layer Mask (Маске слоя). 
Если вдруг вы заметили, что стираете нужную вам область, просто смените 

цвет инструмента Brush (Кисть) (B) на белый и удалившаяся область 
начнёт восстанавливаться. 

Шаг 8 
Теперь, давайте продублируем изображение с фоном (Ctrl+J) и 

применим его в качестве Clipping Mask (Обтравочной маски) к слою с каплей 
(для этого нужно навести мышь на область между копией слоя и слоя с 
каплей, зажать клавишу Alt и сделать левый клик мышью.) Затем измените 
режим наложения копии слоя на Color (Цвет) и Opacity (Непрозрачность) 
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уменьшите до 70%. Результат на скриншоте: 

 
Шаг 9 
А сейчас пришло время добавить модель в наш документ. 

Предварительно, не забудьте отделить её от фона. 
Примечание переводчика: можно использовать любые инструменты 

выделения. Главное - чтобы было аккуратно. Процесс рисования волос я уже 
описывал в этом уроке https://photoshop-master.ru/lessons/photo/retush-
studiynogo-foto-v-fotoshop.html 

После того, как модель будет добавлена, разместите её под каплей. При 
помощи инструмента Free Transform (Свободное транформирование) (Ctrl+T) 
немного уменьшите, а затем отразите по вертикали Flip Vertical (Отразить по 
вертикали). Назовите этот слой woman. Результат: 

 
Шаг 10 
Создадим новый слой Shift+Ctrl+N и сразу же изменим его режим 

наложения на Screen (Экран). Сейчас мы создадим нечто вроде воздушной 

перспективы. При помощи инструмента Brush (Кисть) (B) разного 
диаметра, с цветом #795228, сделайте несколько кликов в области модели, 
чтобы было примерно как на скриншоте. Opacity (Непрозрачность) слоя 
уменьшите до 50%. 
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Шаг 11 
Давайте снова продублируем фон изображения, вернее его копию. 

Поместим её в самый верх списка слоёв и изменим режим наложения на 
Normal. Также, не забудьте вернуть Opacity (Непрозрачность) этого слоя до 
100%. Перейдём в Filter - Distort - Pinch (Фильтр - Искажение - Дисторсия) и 
поставим Amount (Радиус) -100, чтобы получился такой результат: 

 
При помощи инструмента Free Transform (Свободное 

трансформирование) (Ctrl+T) уменьшим изображение до размеров капли и 
разместим на том же месте, где находится сама капля. Отразите её по 
вертикали (Ctrl+T - правый клик на выделенной области Flip Vertical 
(Отразить по вертикали)). Теперь нам нужно удалить лишние участки, чтобы 
эта область стала такой же, как и капля. Уменьшите Opacity 
(Непрозрачность) до 60% и на белой маске слоя, чёрной кистью, пройдитесь 
по лишней области, для её удаления. Примечание переводчика: ничего 
страшного, если вы стёрли нужную область. Для её восстановления 
переключите кисть на чёрный цвет (X) и прорисуйте по этой области. Таким 
образом получается рефлекс. 

Результат: 
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Шаг 12 
Осталось провести финальные настройки. Создадим новый 

корректирующий слой Gradient Map (Карта градиента). Дважды кликнув на 
цветовом переходе, выберите из появившегося списка градиент под 
названием Sepia 4 и измените режим наложения на Hue (Цветовой тон), а 
также уменьшите Opacity (Непрозрачность) этого слоя до 20%. Настройки на 
скриншоте: 

 
Результат: 

Создайте новый 
корректирующий слой Color Lookup (Поиск цвета). В списке рядом с 
3DLutFile выберите Candlelight.CUBE. Opacity (Непрозрачность) уменьшите 
до 10%. Настройки на скриншоте: 
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Результат: 

Далее, создайте новый 
корректирующий слой Curves (Кривые) и применим такие же настройки, как 
на скриншоте: 

90 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
И вот мы получаем финальный результат. Урок оказался очень простым 

и я надеюсь, что полученный результат вам понравился. Нажмите на 
изображение, чтобы увеличить. 
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Порядок расположения слоёв прилагается: 

 

Тема 6. Цифровая фотография. Тоновая и цветовая коррекция 
 
Природа цифрового изображения. Способы получения цифровых 

изображений. Цифровая фотография: студийная и экстерьерная съемка. 
Визуализация цифрового изображения. Входные и выходные характеристики 
изображения: линейный размер, входное и выходное разрешение 
изображения. 

Цветовые простанства Bitmap, Greyscale, Duotone, Index, RGB, CMYK, 
HSB, Lab. Их назначение. Преобразование цветовых пространств. Глубина 
цвета. Цветовоспроизводящие устройства: Adobe RGB, Apple RGB, sRGB, 
Euroscale, SWOP Color Managment Systems.   

Предварительный анализ изображения. Гистограмма и цветовая проба 
как средства анализа. Этапы обработки фотографий. Уменьшение эффекта 
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цифрового шума. Сглаживание цветовых переходов. Устранение эффекта 
“красных глаз”. 

Понятие коррекции. Корректирующие слои.  Глобальная и локальная 
коррекция изображения.  

Тоновая и цветовая коррекция изображения. Тоновый диапазон 
изображения. Команда Histogram. Средства тоновой коррекции: 
Brightness/Contrast, Auto Levels, Levels. Коррекция с помощью градационных 
кривых. Команда Curves.    

Глобальная цветовая коррекция. Команда Color Balance. Избирательная 
цветовая коррекция. Команда Hue/Saturation. Многоканальная цветовая 
коррекция. Ключевой канал в цветокоррекции. Особенности коррекции в 
CMYK и в Lab. Регулировка цветового баланса фотографий. Тонирование 
изображений цветом.  

Манипуляции с каналами. Контраст. Улучшение контраста слиянием 
каналов. Резкость. Методы повышения резкости. Нерезкое маскирование. 
Проявление и сохранение деталей в тенях в наиболее важных областях 
изображения. Команда Channel Mixer.  

Ретушь. Приемы восстановления, реставрации и перекомпоновки. 
Ретуширование портретов. Работа с изображениями текстур.   

 
 

Лабораторная работа 5 
СОЗДАНИЕ ФОТОРЕАЛИСТИЧНОГО ИЗОБРАЖЕНИЯ. 

ШАГ 1Создаем новый рабочий документ с парраметрами, как на 
скриншоте.  
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ШАГ 2 
Из папки с изображениями (или из интернета) берем картинку острова. 

Перетягиваем ее в наш документ. Масштабируем с помощью  «горячих» 
клавиш CTRL+T. Не забываем зажать SHIFT для пропрорционального 
масштабирования. 

 
Когда картинка подогнана под размер окумента, нажмите галочку 

вверху.  
ШАГ 3 
Далее работаем с инструментом градиент. Важно: Если значка градиента 

нет и вы его не нашли. Посмотрите внутри группы за Заливкой.  Напоминаю 
что все инструменты со стрелочкой справа открываются и внутри них есть 
еще инструменты 
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ШАГ 4 
Если вы нашли инструмент. Нужно его настроить. Вверху, под меню у 

каждого инструмента есть парраметры.  Вот настройки градиента. 

 
 
     1  2   3 
1. Редактор градиентов (настройка шветов и направления) 
2. Виды градиентов (линейный, радиальный, конусовидный, зеркальный, 

ромбовидный) 
3. Режимы наложения. (Точно такие же как и в слоях.) 
Эти 3 пункта нужно запомнить. Что бы в дальнейшем пользовоться 

градиентом.  
Для нашей картинки с черепом- остравом нам нужно настроить 

градиент, который будет симулировать воду.  
Для этого создаем новый слой. Кликаем по окошку редактора 

градиентов. 
нижний ползунок 

отвечает за цвет. Нам 
нужно взять образец 
цвета с картинке, что бы 
максимально похоже 
сделать. 

Если присмотрется 
к курсору мыши, мы 
увидим, что он похож на 
пипетку. Им-то мы и 
будем брать пробу цвета. 
Сначала самого светлого, 
а потом самого темного. 

Настроили 
градиепн- жмем ОК. 

 
 
ШАГ 5 
Проверяем остальные настройки.  
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На новом слое, который мы создали проводим линою инструментом. 
Вертикально вниз 

Слой с градиентом перекрыл все 
остальные. Что бы картинка была видна. 
Поменяем ее местами с градиентом.  

Теперь картинка будет сверху. 
 
 
 
 
 
 
ШАГ 6 
Теперь у картинки четкая нижяя граница. 

Убераем ее ластиком с настройками: 

 
Получается вот так: 
 

Делаем воду реалистичной. Добавляем 
фильтр Облака. 

 Внимание!!! Перед 
применением фильтра убедитесь 

что цвета выбраны по умолчанию. 
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Сверяем с картинкой. У вас должно быть точ в точь.  4 слоя на панели. 

После применения фильтра добавится еще один 
слой. 

Для него применяем режим наложения- Перекрытие 
и заливку уменьшаем до 17% 

Что должно произойти. Эфект «Облака» снижен. Вы 
видиье легкую рябь.  

ШАГ 7 
Добавляем картинку дна морского. Из папки или из 

интернета. Стираем край ластиком. 

 
 ШАГ 8 
Добавляем череп. 
Инструментом «волшебная палочка» удаляем белый фон и подгоняем 

размеры. Масштабируем череп, что бы его вершняя часть была размером с 
остров.  
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ШАГ 7 
Накладываем текстуру скалы. Режим ноложения- перекрытие.  

 
ШАГ 8 
Удаляем лишние части текстуры. Обрезать ее нужно в 

форме черепа. Поэтому, зажимаем клавишу CTRL и кликаем 
по слою с изображением черепа.  Побежали «мурашки» 
выделения. Далее нажимаем горячие клавиши CTRL+SHIFT+i 
для инверсии выделения. Картинку должна обрамлять рамка 
из мурашек. Если так произошло- все верно. 

Переходим на слой с текстурой. Нажимаем Delete. 
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ШАГ 9 
Нам остается сделать цветовую и тоновую работу. Будем пользоваться 

корректирующими слоями. Расроложениы они 
ниже панели слоев.  

 
 

В списке можно найти разного рода коррекции. Почему стоит 
пользоваться именно корректирующими слоями, да потому, что их эфекты 
можно менять. А если пользоваться меню Изображение- коррекция. После 
применения невозможно ничего изменить.  

Текстуру скалы нам нужно сделать контрастнее. Используем 
соответствующий корректирующий слой.  

Напимер я хочу применить цветовой тон и насыщенность к морскому 
дну. Выбираю картинку в списке слоев и захожу в корректирующие. Ищу 
цветовой тон 

 
Сейчас корректирующий слой действует на всю картинку, а нам нужно 

применить только к картинке с дном. Мы зажимаем клавишу ALT и кликаем 
между слоями с дном и 
коректирующим слоем.  
Появляется значек. Это 
обтравочая маска.  

 
 
 
 
 
 

 
В общем и целом это все, что нужно знать, для создания 

фотореалистичных обьектов.   
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Тема 7. Компьютерная графика  в  веб-пространстве.  
 

Лабораторная работа 7. 
Создание Гиф-анимированного баннера, оптимизация изображений для 

Веб.  
 
При правильном размещении, анимация может привлечь интерес к 

определённой области страницы. Сегодня мы, используя возможности 
Photoshop CS5, создадим анимированный GIF.  

Создайте новый документ размером в 250 х 250 пикселей и установить 
разрешение в 70 пикселей, цвет фона залейте цветом  # f2f2f2. 

 

 
 Поместите логотип в центральной верхней части холста. Напишите 

слоган под логотипом. Нарисуйте прямоугольник и залейте его цветом 
 правой части логотипа (возьмите пробу пипеткой). 

      
Откройте диалоговое окно Стиль слоя (layer styles) и выберите Тень 

(Drop shadow). Уменьшите Расстояние и Размер до 2 пикселей. 
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 Далее добавьте Наложение градиента (Gradient Overlay) и установите 

Режим наложения на Умножение (Multiply) с Непрозрачностью в 28%.  

  
 

 Теперь добавьте Обводку (Stroke) и уменьшить размер на 1 
пиксель. Установите цвет # a31b1b.  

 
Добавьте несколько слой  с текстом. В нашем случае мы добавили текст: 

Tutorials как показано на рисунке. 
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 Теперь добавьте «картинку к анимации» . В нашем случае мы 
использовали значок программы PSDTUTS, но вы можете использовать все, 
что подходит для ваших целей. 

Чуть ниже картинки добавьте текст «Premium 
Membership». 

Теперь откройте панель анимации и настройте ключевые кадры у 
имеющихся слоёв на Ваше усмотрение. Можно менять стили, прозрачность и 
положение объектов. 

 Шаг 11. Если у вас отсутствует фантазия, можете воспользоваться 
скриншотом раскадровки баннера. 

 Ваша шкала должна быть похожа на приведенный ниже пример. 
  
  

 
  
  
Шаг 12 
  
Мы завершили нашу анимацию. Нажмите кнопку Выполнить, чтобы 

увидеть ваш результат. Вы можете изменить его в случае 
необходимости. Чтобы сохранить баннер, перейдите в меню Файл> 
Сохранить для Web и устройств. Затем используйте настройки из 
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следующего изображения (Формат ГИФ и проигрывать ВСЕГДА) и нажмите 
кнопку Сохранить. 

  
  

 
 

 Методы оптимизации компьютерной графики. 
 

Теоретические сведения: 
Размер файла изображения (его «вес») в Кб напрямую зависит от нескольких 
параметров: 

1. Цветовое решение картинки - играет самую большую роль. Чем больше 
оттенков и мелких деталей на картинке, тем сложнее будет уменьшить это 
изображение. Предмет, сфотографированный на однотонном матовом фоне, 
лучше оптимизируется, чем тот же предмет на пестром фоне. 

2. Геометрические размеры изображения также определяют размер файла в Кб. 
Оптимальные размеры изображения для просмотра на среднестатистическом 
мониторе – не более 800 х 600 пикселей (точек). 

3. Глубина цвета (битовое разрешение). По умолчанию в Adobe Photoshop 
установлена 8-битная глубина цвета, не стоит ее изменять.  

4. Перед оптимизацией рекомендуется сделать предварительное 
редактирование фотографии (а именно, кадрирование и удаление лишних 
деталей фона) можно добиться высокого качества компрессии.  

5. Каждое последующее пересохранение отредактированного файла формата 
JPEG вызывает повторное сжатие изображения, приводя к невосполнимым 
потерям его качества, и в первую очередь именно резкости. Если после 
сохранения вы не удовлетворены качеством, лучше начать сначала, а не 
переделывать сохраненный файл.  
Отсюда вывод – всегда работайте с копиями, оставляя оригинал 
нетронутым! 
Порядок выполнения: 
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1. Выберите File (Файл) —> Save For 
Web (Сохранить для Web) (Рис. 2). 
2. В центре открывшегося окна 
размещается оптимизируемая картинка. 
Щелкните на заголовок Optimized 
(Оптимизация) в верхней части окна 
(зачастую окно с заголовком открывается 
Optimized по умолчанию). 
3. Уменьшим геометрические 
размеры изображения. Щелкните на 
заголовке Image Size (Размер 
Изображения) в правой части экрана. В 
полях Width (Ширина) или Heigth 
(Высота) изменяем значения. По самой 
длинной стороне выставляете цифру 600 
или 800. Включаете (или если включено, 
оставляете включенной) галку около 
Constrain Proportions для сохранения 
пропорций изображения (рис. 4). 
Установив размер, щелкните кнопку 
Apply (Применить) чтобы применить 
новый размер. Если размеры ширины или 
высоты картинки уже меньше  
800-600 точек, то менять ничего не 
нужно. 
Окно Save for Web сохраняет пропорции 
изображения  

4. В поле формат из выпадающего 
списка выберем тип выходного 
файла JPEG (Рис. 5). 

 

  
Рис. 5 

 
Рис. 2 

 
 

 
Рис. 3 

 
 

 
 

Рис. 4 
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В поле ввода Quality (Качество) ставим 
цифру 50. Чем эта цифра больше, тем 
лучше будет фотография. 
5. Выберем качество сжатия 
(компрессии) изображения: щелкните на 
круглую кнопку со стрелкой (Рис. 6). 
Затем в появившемся меню нужно 
выбрать строку Optimize for file size 
(Оптимизировать по размеру файла). 
Откроется диалоговое окно. В поле 
Desired File Size введите с клавиатуры 
цифру 30. Щелкните кнопку OK. 
Программа автоматически 
оптимизировала изображение до 30Кб. 

В левом нижнем углу окна Save for Web 
указан наиболее важный параметр всего 
процесса уменьшения изображения (Рис. 
7) — размер файла, который не должен 
превышать установленный лимит в 30 
Кб. После манипуляций обращайте на 
этот параметр, возможно, что на каком-то 
этапе вы уже добились требуемого 
значения, без существенной потери 
качества. 

 
Рис. 6 

 
 
 

 
Рис. 7 

 
 

6. Если качество изображения значительно «упало», а размер еще велик, 
уменьшим геометрические размеры картинки еще раз (п. 3). Уменьшите 
большую из сторон сначала на 100 пикселей (вместо "800" поставьте сначала 
700, а если тоже будет большой размер, то поставьте 600) и повторите пункт 5. 
Повторите его необходимое число раз, контролируя «вес» файла и качество 
изображения. 
Если «вес» файла не превышает 30Кб и качество вполне приемлемо, то 
щелкните на кнопке Ok (справа вверху окна Save for Web) и, выбрав имя 
файла и путь к нему, сохраните его на диск. 

Оптимизация изображений в формате GIF 
 

1. Загрузите изображение в Photoshop. Выберите File (Файл) —> Save For Web 
(Сохранить для Web). 

2. Эту последовательность мы уже делали чуть раньше. 
3. В диалоговом окне нажмите на закладки вверху окна для просмотра 

изображения в одном из типов: 
• Original — просмотр Оригинала;  
• Optimized — оптимизированное изображение с учетом заданных параметров 

оптимизации; 
• 2-Up — одновременный просмотр Оригинала и оптимизированного 

изображения; 
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• 4-Up — одновременный просмотр Оригинала и трех оптимизированных 
изображений с разными параметрами (рис. 2). 
Окошечко подсвечивается синей рамкой, чтобы узнать какое из них активно 
в данный момент. 

Рис. 2 
 

4. Выберите в списке Формат файла - GIF 

 
Рис. 3. 

5. Переместите ползунок Lossy  или введите число для удаления части 
пикселов из изображения, тем самым уменьшится размер файла. Вы можете 
изменять этот параметр от 5% до 30%, не боясь сильно ухудшить качество 
рисунка. Размер файла при этом уменьшается существенно, в зависимости от 
выбранных опций. 
Нельзя использовать этот параметр с включенной опцией Interlaced 
(Чересстрочная развертка). 

6. Задайте палитру цветов. Формат GIF сохраняет прямо в файле используемые 
в изображении цвета, вот только их количество ограничено числом 256. Зато 
это могут быть любые цвета. Чаще используется Perceptual 
(Перцепционная). 

7. Параметр Colors. Его значение показывает максимальное количество цветов 
в изображении. Если у вас файл содержит полноцветное изображение с 
большим количеством цветов, то значение должно быть максимальным. Если 
укажите меньше, чем требуется, то возможны искажения в цветопередаче. 

8. Для создания чересстрочной развертки изображения отметьте опцию 
Interlaced. При загрузке изображения оно будет появляться постепенно, 
вначале показывая рисунок с плохим качеством, а потом постепенно 
улучшая. 
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9. Если вам необходимо изображение с прозрачным фоном, то установите 
галочку Transparency (Прозрачность). Изображение готово к сохранению! 
Нажмите ОК. 

1. Удалить цвет 
2. Новый цвет 
3. Заблокировать цвет 
4. Ближайший цвет 
5. Прозрачность выделенного цвета 
6. Количество выбранных цветов 
7. Меню таблицы цветов 

На вкладке Color Table (Таблица цветов) 
отображается палитра всех цветов, которые 

содержатся в изображении. Внизу находятся кнопки.  
Если дважды щелкнуть на каком-либо цвете палитры, то откроется окно 

Палитра цветов. В меню палитры цветов можно выбрать команды 
изменения, сортировки цветов, загрузки и сохранения палитры. 
Параметры оптимизации PNG-файлов 

В случае формата PNG-8 (количество цветов не более 256) параметры 
оптимизации те же, что и для формата GIF, за исключением того, что 
параметра Lossy нет. Для формата PNG-24 (24-битная глубина цвета) вы 
можете лишь указать значения параметров Transparency (Прозрачность) и 
Interlaced (Чересстрочный). 

Вкладка Color Table (Таблица Цветов) может использоваться только для 
PNG-8 также, как для формата GIF. На вкладке Image Size (Размер 
изображения) можно изменить размер или разрешение картинки. 

 
Задача№1 

Откройте изображение z15_1.jpg., z15_2.jpg. Оптимизируйте предложенные 
изображение (размер файла не более 300 кб) в Adobe Photoshop для 
дальнейшего размещения в Internet в форматах png и gif.  

Задача№2 
Откройте изображение бабочки и муравья. Отделите бабочку и муравья от 

фона и сохраните файлы с прозрачным фоном.  
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4. РАЗДЕЛ КОНТРОЛЯ ЗНАНИЙ 
 
В качестве одного из элементов, рекомендуемого для выявления уровня 

учебных достижений студента, используются критериально- 
ориентированные тесты. Они представляют собой совокупность тестовых 
заданий закрытой формы с одним или несколькими вариантами правильных 
ответов; заданий открытой формы с формализованным ответом; заданий на 
установление правильной последовательности. 

Для измерения степени соответствия учебных достижений студента 
требованиям образовательного стандарта также рекомендуется использовать 
проектную деятельность, включающую проблемные, творческие задачи, 
предполагающие эвристическую деятельность и неформализованный ответ. 

 
4.1. ЗАДАНИЯ ДЛЯ КОНТРОЛИРУЕМОЙ САМОСТОЯТЕЛЬНОЙ 

РАБОТЫ СТУДЕНТОВ 
Методические рекомендации 

по организации и выполнению самостоятельной работы студентов по 
учебной дисциплине 

Самостоятельная работа студентов направлена на обогащение их умений 
и навыков по учебной дисциплине «Компьютерная графика» в свободное от 
обязательных учебных занятий время. Цель самостоятельной работы 
студентов – содействие усвоению в полном объеме содержания учебной 
дисциплины через систематизацию, планирование и контроль собственной 
деятельности. Преподаватель даёт задания по самостоятельной работе и 
регулярно проверяет их выполнение. 

Дисциплина изучается в течение одного семестра и предусматривает 
самостоятельную работу студентов. К зачету студент должен представить 
созданные им проекты. Предполагается теоретический контроль знаний в 
виде итогового теста или ответа на вопросы. Перечень вопросов и тест 
прилагаются. 

 
 
Тема 5. Композитные изображения. Создание композиций. 

Проект: “Афиша”. 
- создание красочной надписи, создание текстовых эффектов. 

- создание из многофайлового документа многослойного коллажа. 
- нанесение узоров и текстур на изображение. 
- откорректировать фотографии, используя корректирующие слои 

научиться тонировать отдельные части изображения. 
- создание профессионального коллажа при помощи масок. 
 
Тема 6. Тоновая и цветовая коррекция. 
Создание авторского проекта. Проект: “Историческая реконструкция 

портрета”. 
- создание профессионального коллажа при помощи масок. 
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- нанесение узоров и текстур на изображение, раскрашивание 
фотографии. 

- используя команды коррекции откорректировать фотографии, 
используя корректирующие слои научиться тонировать отдельные части 
изображения. 

 
 

4.2. ТЕСТ НА ЗНАНИЕ ГРАФИЧЕСКОГО РЕДАКТОРА ADOBE 
PHOTOSHOP 

 
 
1. Каким является графический редактор Adobe Photoshop? 
⃝  Фрактальным. 
⃝  Прямолинейным. 
⃝  Векторным. 
⃝  Растровым. 
⃝  Затрудняюсь ответить. 
 
2. Элементарным объектом растровой графики является: 
⃝  примитив. 
⃝  то, что рисуется одним инструментом. 
⃝  пиксель. 
⃝  символ. 
⃝  Затрудняюсь ответить. 
 
3. Что означает аббревиатура RGB? 
⃝  Red, Great, Black. 
⃝  Red, Green, Blue. 
⃝  Red, Green, Black. 
⃝  Right, Good, Bad. 
⃝  Затрудняюсь ответить. 
 
4. Какое расширение файлов является в Adobe Photoshop основным? 
⃝  .GIF. 
⃝  .JPG. 
⃝  .PSD. 
⃝  .BMP. 
⃝  Затрудняюсь ответить. 
 
5. Сетка, которую на экране образуют пиксели, называется: 
⃝  Видеопамять. 
⃝  Растр. 
⃝  Видеоадаптер. 
⃝  Дисплейный процессор. 
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⃝  Затрудняюсь ответить. 
 
6. Какую из перечисленных ниже операций нельзя выполнить при 

помощи Photoshop? 
⃝  Создать Flash ролик 
⃝  Создать оригинальный фотоколлаж 
⃝  Реставрировать старые фотографии 
⃝  Просмотреть гистограмму изображения 
⃝  Открыть векторный файл ESP 
⃝  Редактировать видео 
⃝  Затрудняюсь ответить. 
 
7. Как называется инструмент, позволяющий 

залить изображение двумя плавно перетекающими друг в друга цветами? 
⃝  Заливка. 
⃝  Банка краски. 
⃝  Градиент. 
⃝  Узор. 
⃝  Затрудняюсь ответить. 
 
8. Верно ли, что созданный по умолчанию фоновый слой 

поддерживает прозрачность? 
⃝  Да. 
⃝  Нет. 
⃝  Затрудняюсь ответить. 
 
 
9. Какой один из перечисленных ниже инструментов отсутствует в 

Photoshop? 
⃝  Архивная кисть (History Brush) 
⃝  "Размазывающая кисть" (Smudge Brush) 
⃝  "Восстанавливающая кисть" (Healing Brush) 
⃝  "Палец" (Smudge) 
⃝  Затрудняюсь ответить. 
 
10.  Что за инструмент? 
⃝  Перо. 
⃝  Волшебная палочка. 
⃝  Перемещение. 
⃝  Вырезание. 
⃝  Выделение контура. 
⃝  Затрудняюсь ответить. 
 
11.  Что за инструмент? 
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⃝  Историческая кисть. 
⃝  Осветление. 
⃝  Автоматизация. 
⃝  Волшебная палочка. 
⃝  Размывание.  
⃝  Затрудняюсь ответить. 
 
12.  Что за инструмент?  
⃝  Прямоугольное выделение. 
⃝  Прямоугольное кадрирование. 
⃝  Рисование прямоугольника. 
⃝  Прямоугольный фрагмент. 
⃝  Перемещение. 
⃝  Затрудняюсь ответить. 
 
13. Какой клавиатурной клавишей можно быстро открыть панель слоёв 
⃝  F3 
⃝  F5 
⃝  F7 
⃝  F9 
⃝  Затрудняюсь ответить. 
 
14. Удерживая какую клавиатурную клавишу, можно проводить 

идеально прямые линии с инструментом "Кисть" 
⃝  Tab 
⃝  Shift 
⃝  Alt 
⃝  Ctrl 
⃝  Затрудняюсь ответить. 
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4.3. ПЕРЕЧЕНЬ ТЕОРЕТИЧЕСКИХ ВОПРОСОВ 
 И ПРАКТИЧЕСКИХ ЗАДАНИЙ 

ДЛЯ ПРОВЕДЕНИЯ ЗАЧЕТА 
ПО УЧЕБНОЙ ДИСЦИПЛИНЕ ПО ВЫБОРУ «КОМПЬЮТЕРНАЯ 

ГРАФИКА» 
 

1. Основы компьютерной графики. 2D и 3D графика.  
2. Графика растровая, векторная и фрактальная, достоинства и 

недостатки. 
3. Цвет и модели цвета. Цветовой охват.  
4. Цифровая цветовая модель RGB. Типографская цветовая модель 

CMYK.  
5. Пользовательская цветовая модель HSB и Lab.  
6. Форматы растровой графики. Совместимость форматов.  
7. Входные и выходные характеристики изображения: линейный 

размер, входное и выходное разрешение изображения.  
8. Элементы интерфейса Adobe Photoshop. Работа с палитрами. 

Рабочее пространство. Навигация в окне документа. Настройки программы. 
Работа с документом. Создание и сохранение документа. Организация окон. 
Панели. 

9. Ручные инструменты выделения и приемы создания выделенных 
областей. Режимы выделения. Автоматические инструменты выделения. 
Команды для работы с выделенными областями. Модификация выделенной 
области. Меню «Выделение». 

10. Команды трансформации, особенности применения. Операции с 
выделенными фрагментами. Отмена трансформации.  

11. Масштаб с учетом содержимого. Кадрирование изображения. 
Сложные комбинации: работа с клавиатурой.  

12. Вставка изображений в слой. Смарт-объекты.  
13. Палитра Слои. Перемещение и копирование слоев. Видимость и 

блокировка слоя. Прозрачность слоя. Фон.  
14. Редактирование слоев. Группы. Сведение. Создание 

многослойного изображения. 
15. Основы комбинирования изображений. Приемы реалистичного 

наложения рисунка на объект. Режимы смешивания слоев.  
16. Основные приемы рисования. Работа с цветом. История 

действий. Инструмент заливка. Контуры и узоры.  
17. Инструмент обводка. Инструмент градиент.  
18. Кисти. Прозрачность и жесткость кисти. Пользовательские 

настройки. Создание собственных инструментов рисования.  
19. Режимы наложения пикселов цвета.  
20. Приемы и инструменты фотореалистичного раскрашивания и 

тонирования фотоизображений. Тени, блики, свет. Применение режима 
«цветность».  
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21. Понятие векторного изображения. Контуры. Операции с 
фигурами.  

22. Создание и свойства текста. Ввод и редактирование. Палитра 
символ, палитра абзац, текст вдоль пути. Блочный текст.  

23. Текст как выделение. Растрирование текста.  
24. Понятие стилизации слоя. Добавление эффектов к слоям. 

Комбинирование, редактирование и удаление эффектов.  
25. Галерея фильтров. Работа с фильтрами. Категории фильтров.  
26. Имитация традиционных методик живописи и графики и 

транспонирование их в компьютерные творческие технологии.  
27. Фильтр «Пластика». Смарт-фильтры.  
28. Понятие ретуши. Приемы восстановления, реставрации и 

перекомпоновки изображений. Комплексность приемов инструментов 
ретуши.  

29. Портретная ретушь.  
30. Команды тоновой коррекции: Яркость/Контрастность. Уровни. 

Кривые. Команды цветовой коррекции: Цветовой баланс. 
Оттенок/Насыщенность. Замена цвета, выборочная коррекция цвета.  

31. Автоматическая коррекция. Установка точек вручную. Тени и 
света. Тонирование фотографий любым оттенком. 

32. Создание и редактирование корректирующего слоя. Маска 
отсечения (обтравочная маска). Палитра свойств корректирующего слоя. 

33. Правила маскирования слоев. Маска как профессиональный 
способ коллажирования.  

34. Типы масок: маска слоя, (маска отсечения), векторная маска.  
Маска слоя. Связь со слоем. Отключение и удаление маски слоя.  

 
ЗАДАНИЯ ДЛЯ САМОКОНТРОЛЯ 

 
Тема 1. Теоретические основы компьютерной графики и  

геометрического моделирования 
 

1. Какие из перечисленных объектов не являются геометрическими? 
а) точка, б) окружность, в) газ, г) цилиндр, д) ускорение, е) дорога 
2. Кривая представлена следующим образом: 

x(t), y(t), z(t), 0 ≤ t ≤ 1.  
Данное представление кривой является:  
а) параметрическим, 
б) непараметрическим. 
3. Заполните таблицу преобразований, поставив в соответствие каждому 

математическому представлению преобразования его название, выбрав из 
списка соответствующее: перенос, поворот, масштабирование. 

 
геометрическое представление  /  матричное преобразование 
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представление 

 

 

 
 
 
 
 
 
 

 
4. Выберете из списка названия видов сплайнов: линейный, 

квадратичный, треугольный, сферичный, кубический,  Безье, Люмьер, 
NURBS. 

5. Какой из сплайнов изображен на рисунке: а) линейный, б) 
квадратичный. 

 
6. Подпишите объекты сплайна указанные стрелочками 

7. Каждому виду вершин сплайна поставьте его название 
Безье  вершина, в которой сплайн претерпевает излом. Участки 
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(Bezier)  сегментов вблизи такой вершины не имеют кривизны. 
Сглаже

нная  
(Smooth)  

вершина, позволяющая управлять кривизной сегментов 
сплайна при входе в вершину и при выходе из нее.  

С 
изломом  

(Corner)  

вершина, через которую кривая сплайна проводится с 
плавным изгибом, без излома, имея одинаковую кривизну 
сегментов при входе в вершину и выходе из нее. 

 
Тема 2. Цифровое искусство 

 
1. К синергетичным направлениям цифрового искусства относятся: а) 

демосцена, б) архитектурный коллаж, с) компьютерный перформанс, в) 
живопись маслом с) 3D мэпинг. 

Выберете правильное определение. 
2. Маппинг – это: 
- нанесение с помощью красок географических карт на объект;  
- способ нанесения виртуального изображения на реальный объект; 
- виртуальная платформа для изучения географии. 
3. Интерактивный компьютерный перфоманс – это: 
- вид искусства, который позволяет зрителю (пользователю)  наравне с 

автором участвовать в создании художественного произведения; 
- лекция по компьютерному искусству он-лайн; 
- это он-лайн дискуссия в режиме реального времени на заданную тему; 
4. Для реализации плоского мэппинга медиасервер используется: 
- для дополнительного освещения объекта, на который накладываются 

проекции; 
- для компенсации геометрического искажения от проекторов; 
- для музыкального сопровождения. 
5. Динамический диапазон 
- это скорость, с которой цифровое устройство способно выполнить 

серию снимков; 
- это количество цветов, которое может распознать цифровое 

устройство. 
- это мера спектра освещения на различных уровнях - от темных, черных 

оттенков до самых ярких, белых, которая  определяет количество контраста, 
которое может быть зафиксировано или отображено без потери деталей. 

6. Выберете предложение, относящееся в компьютерной графике к 
аббревиатуре   HDR: 

HDR - это формат изображения. Для его создания которого используется 
информация из нескольких снимков, сделанных с разной экспозицией, на 
которых отчетливо видны детали и светлых, и темных частей снимка.  

HDR - неподвижные и движущиеся изображения, сгенерированные при 
помощи трёхмерной компьютерной графики и использующиеся в 
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изобразительном искусстве, печати, кинематографических спецэффектах, на 
телевидении и в симуляторах. 

HDR - это способ отображения подавляющего большинства цветов 
видимого спектра  благодаря смешиванию  трех цветов (в разных пропорциях 
и с разной яркостью) — красного, зеленого и синего 

 
Тема 3.Трехмерное моделирование 

 
1. Названию каждой модели поставьте в соответствие ее определение. 
Модели конструктивной 

твердотельной геометрии (CSG - 
Constructive Solid Geometry)  

характеризует форму тела 
набором ориентированных 
поверхностей, ограничивающих его. 

Каркасные модели (Wire-frame 
Geometry)  

формируется как композиция 
некоторых областей пространства с 
помощью теоретико-множественных 
операций. 

Модели поверхностей (Surface 
Geometry)  

характеризует форму тела 
набором пространственных линий. 

2. Каждой из картинок б), в), г) укажите названия соответствующих 
булевых операций. 

 
3. Назовите виды преобразований, которые осуществлялись для данных 

объектов 

116 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



4. Какие из списка редакторов относятся к редакторам трехмерной 
графики: 3D-Studio Max; Autodesk Maya; CorellDrow; Blender; PhotoShop;  
Google SketchUp; Sweet Home 3D. 

5. 3D-сканеры делятся на два типа по методу сканирования:  
а) поверхностный и внутрипроникающий; 
б) лазерный и ультразвуковой; 
в) контактный и бесконтактный. 
 

Тема 4. Компьютерная графика в кинопроизводстве 
 

1.  Сопоставьте названия технологий их определениям 
Комбинированн

ая съёмка 
(Сompositing) 

электронный спецэффект, позволяющий создать 
видимость непрерывности переходов, лишенных 
«швов», «заморозить» движение, превратить 
двухмерный объект в трехмерный, показать в кадре 
след от предыдущего кадра, создать и анимировать 
тени и т.д. 

Захват 
движения  

( Motion 
capture)  

разновидность спецэффектов, основанных на 
совмещении двух и более различных изображений, 
созданных независимо друг от друга. 

Морфинг  
(Мorphing)   

технология для записи движений актеров, 
которые затем используются в компьютерной графике. 

Компоузинг 
(Сomposing ) 

технология в компьютерной анимации, 
визуальный эффект, создающий впечатление плавной 
трансформации одного объекта в другой. 

2. CGI это: 
-  периферийное устройство, анализирующее физический объект и на 

основе полученных данных создающее его 3D-модель; 
- неподвижные и движущиеся изображения, сгенерированные при 

помощи трёхмерной компьютерной графики и использующиеся в 
изобразительном искусстве, печати, кинематографических спецэффектах, на 
телевидении и в симуляторах; 
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-  многоплатформенный графический 3D пакет, распространяемый с 
открытым исходным кодом. 

3. Хромакей -  это: 
- технология совмещения двух или больше слоев видео в одном кадре; 
- компьютерный эффект, создающий у 3D персонажа хромую походку; 
- зеленое полотно, которое используют как фон на съемеочной 

площадке. 
 

Тема 5. Композитные изображения. Создание композиций. 
Пользуясь конспектом лекций, вставьте название соответствующей 

композиции 
1.________________композиция лежит в основе реалистических 

художественных произведений 
2. признаком _______________________________ композиции является 

распределение в одной плоскости элементов формы в двух направлениях по 
отношению к зрителю: вертикальном и горизонтальном, например, стенды 
наглядной агитации, ткани, ковры, фасады зданий и т.д 

 
3. _________________композиция  представляет собой форму, имеющую 

относительно замкнутую поверхность и воспринимаемую со всех сторон. 
_________________ композиция всегда взаимодействует с окружающей 
средой. Среда может увеличивать или уменьшать выразительность одной и 
той же композиции.Характеризуется развитием пространственных элементов 
в трех координатных направлениях при соблюдении их компактности. 

4. ______________________ композиция отличается небольшой 
глубиной и преимущественно фронтальным расположением элементов 

5. ________________________композиция вписывается обычно в какие-
либо архитектурные формы или связывается с другими произведениями 
прикладного искусства, и, следовательно, само является частью другой, 
большей композиции 

 
Тема 6. Цифровая фотография. 

1. Назовите цветовые модели поддерживающие следующие количество 
цветов 

а) два цвета; 
б) всего 256 цветов; 
c) более 16 миллионов цветов. 
2. Назовите базовые цвета модели CMYK, расшифруйте кажый из 

цветов, соответствующих буквам аббревиатуры. 
3. Для вывода на печатьи полноценной передачи цветов используют 

модель: а) RGB; б) Bitmap; c)  CMYK. 
4. Какая модель из моделей является аддитивной: а) RGB; б)  CMYK. 

Объясните почему эта модель называется аддитивной. 
5. Вставьте пропущенные аббревиатуры  названий цветовых моделей: 
Модель _________ основана на восприятии цветов окружающего мира 
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центральной нервной системой человека. Хотя модель ________ 
декларирована как аппаратно-независимая, на самом деле в её основе лежит 
_______. В любом случае ________ конвертируется в _________ для 
отображения на мониторе и в ____________для печати,а любая конвертация 
не обходится без потерь. 

 
Тема 7. Компьютерная графика в  веб-пространстве. Ресурсы 

компьютерной графики в Интернет 
 
Вставьте  число, соответствующее содержанию предложения 
1.Формат GIF имеет цветовую палитру, состоящую из ___________ 

цветов. 
2.  Дизайнеры стремятся к тому, чтобы Web-страница не превышала по 

объему ___________ Кбайт. 
3. Особенность графики для Web заключается в жестких ограничениях, 

накладываемых на объем файлов. Это связано с пропускной способностью 
каналов связи. Если Web-страница загружается в браузер дольше ______ с. 
это считается плохим показателем разработки ресурса. 

4. JPEG поддерживает более ________________ цветов. Формат JPEG 
сжимает изображения с потерей качества. Алгоритм сжатия основан на 
разбиении исходного изображения на квадраты ____×___ пикселей, и 
последующей их группировке. 

5.  WebP  сжимает изображения без потерь лучше, чем PNG на _____ по 
данным Google и сжимает изображения с потерями лучше, чем JPEG на 
________ по данным Google. 

 
6. Какие из указанных в списке форматов являются векторными: GIF, 

JPEG, PNG, WebP, SVG? 
7. Какой формат наилучшим образом подходит для хранения 

изображения, соответствующим следующим описаниям 
В1  
-изображение не многоцветное; 
-нужна простейшая прозрачность; 
-нужна анимация. 
В2 
- полноцветных изображений, фотографий; 
- изображений, с плавным переходом яркости и контраста; 
- рисунков с большим количеством разноцветных деталей. 
В3  
-изображений с прозрачностью и полупрозрачностью; 
- когда необходима повышенная точность полноцветных изображений; 
- изображений с резкими переходами цветов. 
 
В4  
- нужно анимировать части изображения; 
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- изменять цвет элементов изображения; 
- необходимо масштабировать изображение без потерь. 
 

Тема 8. Допечатная подготовка. 
Вставьте пропущенные числа. 
1. Макет дизайна проверяется на расположение значимых элементов 

вблизи линии реза и в корешке. Обычно, эта величина не должна быть менее 
_____ мм. Необходимо грамотно расположить элементы на полосе, идущие 
на вылет (bleed), им следует задать размер вылета. Стандартно - ____ мм. 
При размещении изображений на вылет необходимо следить, чтобы не 
зарезались значимые элементы работы.  

2. В процессе допечатной подготовки издания обычно применяется два 
этапа работы с изображениями. Первоначально делается первичная 
обработка изображений: цветокоррекция; ретушь. Следует учитывать, что 
векторные полутона, градиенты и прозрачности должны быть растрированы, 
растровые элементы, изображения – должны быть в формате «CMYK» и 
________ dpi. 

3. Второй этап представляет собой работу с вёрсткой. Здесь необходимо 
– наращиваются вылеты. Для изображения устанавливается масштаб _______ 
и разрешение согласно выбранной линиатуре печати. В самом конце 
производится процедура предпечатной обработки изображений. 

Пользуясь конспектом лекций вставьте пропущенные выражения. 
1. Важный аспект – это грамотное размещение изображений на 

развороте. Согласно правилам препресс, нежелательно чтобы основные 
объекты попадали ______________. 

2. Необходимо указывать наличие или отсутствие ________________. 
Все шрифты и тексты должны быть переведены ____________, а черный 
текст – _____________. В первичной обработке художественных элементов  
присутствуют _____________; ______________ согласно выбранному типу 
печати и бумаге; переименование файлов согласно принятым специалистами 
по допечатной подготовке правилам - ________________________, а также 
сохранение изображений в правильном формате (________ или ________).  

3. Второй этап представляет собой работу с вёрсткой. Здесь необходимо 
– наращиваются ____________________. 

4. _____________ - язык описания страниц, в основном используемый в 
настольных издательских системах. Это конкатенативный язык 
программирования с динамической типизацией. ___________ является 
языком управления принтером, а так же полнофункциональным языком 
программирования. Многие прикладные программы могут преобразовать 
документ в __________-программу, при выполнении которой будет получен 
начальный документ. Эта программа может быть послана непосредственно 
на принтер с поддержкой ______________ или преобразована 
интерпретатором ___________________ в другой формат (для принтеров без 
поддержки _________________), или результат её выполнения 
интерпретатором может быть показан на экране.  
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5. ВСПОМОГАТЕЛЬНЫЙ РАЗДЕЛ 
 

5.1.УЧЕБНАЯ ПРОГРАММА (прилагается) 
 

5.2.ОСНОВНАЯ ЛИТЕРАТУРА 
 

1. Агапова,  И. Adobe Photoshop. Чудеса ретуши / И. Агапова. – 
М.: Эксмо, 2012 . – 416 с.  

2. Айсманн, Кэтрин. Маски и композиция в Photoshop.: Пер. с 
англ. / К. Айсман, Ш. Дугган, Д.Порто. – М.: Вильямс, 2013. – 600с.: ил. 

3. Ивнинг, М. Adobe Photoshop для фотографов / М. Ивнинг. – 
М.: BHV, Русская редакция, 2013. – 768 с. 

4. Келби, Скотт. Цифровая фотография. Готовые рецепты / 
К.Скотт. – М.: Вильямс, 2015. – 232 с.: ил. 

5. Корпан, Л. Компьютерная графика и дизайн /Л. Корпан, В. 
Тозик. – М.: Academia, 2014. – 208 с.  

6. Олспач, Тед. Adobe Illustrator CS2. Библия пользователя. – М.: 
Вильямс, 2006. – 656с. 

 
5.3. ДОПОЛНИТЕЛЬНАЯ ЛИТЕРАТУРА 
 
1. Айсманн, Кэтрин. Ретуширование и 

обработка изображений.: Пер. с англ. – М.: Вильямс, 2007. – 484с. 
2. Бернс, С. Фотомагия Photoshop. Трюки и эффекты / С. Бернс. – 

М.: BHV,  Русская редакция, 2008 . – 448 с.  
3. Домасев, М.В. Цвет, управление 

цветом, цветовые расчеты и измерения: учебный курс / М.В. Домасев, 
С.П.Гнатюк. — 1-е изд. — СПб.: Питер, 2009. – 224 с.  

4. Маргулис, Дэн. Photoshop для 
профессионалов: классическое руководство по цветокоррекции. Пятое 
издание / Пер. с англ. — М.: 000 «Интерсофтмарк», 2007. — 656 с: ил. 

5. Маргулис, Дэн. Современная 
технология цветокоррекции в Photoshop. PPW и другие идеи для быстрого 
улучшения изображений / Дэн Моргулис. Пер. с англ. — М.: Погрелый В.Г., 
2015. — 496 с: ил. 

6. Назарова, Ю. Компьютерная графика и 
Web-дизайн. Практикум по информатике / Ю.Назарова, Т. Немцова. – М.: 
Форум, 2013. – 288 с.  

7. Смит, К. Photoshop для цифровой фотографии. Полноцветное 
издание (+ CD) / К. Смит. – М.: BHV, Русская редакция, 2010. – 448 с. 

 

121 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И

http://oz.by/people/more9010687.html
http://oz.by/people/more9010687.html
http://oz.by/producer/more1203.html
http://oz.by/people/more9010235.html
http://oz.by/people/more9010235.html
http://oz.by/producer/more1203.html
http://oz.by/producer/more12090.html
http://oz.by/people/more9091649.html
http://oz.by/people/more9091649.html
http://oz.by/people/more907070.html
http://oz.by/people/more907070.html
http://oz.by/people/more907070.html
http://oz.by/producer/more120511.html
http://oz.by/producer/more1207.html
http://oz.by/people/more909115.html
http://oz.by/people/more909115.html
http://oz.by/producer/more1203.html
http://oz.by/producer/more12090.html
http://oz.by/people/more9046310.html
http://oz.by/people/more9046309.html
http://oz.by/people/more9046310.html
http://oz.by/people/more9046309.html
http://oz.by/producer/more120600.html
http://oz.by/people/more904422.html
http://oz.by/people/more904422.html
http://oz.by/producer/more1203.html
http://oz.by/producer/more12090.html

	Тема 2. Цифровое искусство
	Тема 3. Трехмерное моделирование
	Тема 4. Компьютерная графика в кинопроизводстве
	Тема 5. Композитные изображения. Создание композиций.
	Тема 6. Цифровая фотография. Тоновая и цветовая коррекция.
	Тема 7. Компьютерная графика  в  веб-пространстве. Ресурсы компьютерной графики в Интернет.
	Тема 8. Допечатная подготовка.
	ПРАКТИЧЕСКИЙ РАЗДЕЛ…………………………С. 46-107.
	Тема 5. Лабораторная работа 1.
	Лабораторная работа 2.
	Лабораторная работа 3.
	Лабораторная работа 4.
	Тема 6. Лабораторная работа 5.
	Тема 7. Лабораторная работа 6.
	Шаг 1: Создадим новый документ Photoshop
	Шаг 2: Выбираем инструмент Custom Shape
	Шаг 3: Загружаем набор фигур Nature
	Шаг 4: Выбираем снежинку
	Шаг 5: Выбираем опцию Fill Pixels
	Шаг 7: Делаем из фигуры кисть
	Шаг 8: Открываем фотографию
	Шаг 9: Добавим чистый слой
	Шаг 11: Выбираем участок, куда вставить фотографию
	Шаг 12: Удаляем содержимое зоны выделения
	Шаг 13: Расширяем выделение
	Шаг 15: Выбираем инструмент Brush Tool
	Шаг 16: Выбираем кисть-снежинку
	Шаг 17: Задаем динамические опции кисти
	Шаг 18: Делаем из рамки выделения контур
	Шаг 19: Выбираем белый в качестве цвета переднего плана и уменьшаем размер кисти
	Чтобы обратить цвета переднего и заднего плана, установленные в Photoshop по умолчанию, нажмите кнопку X, и тогда передний план станет белым (это нужно потому, что Photoshop рисует тем цветом, который задан как цвет переднего плана). Затем при помощи ...
	Шаг 20: Проводим кистью-снежинкой по нарисованному контуру
	Шаг 1
	Шаг 2
	Шаг 3
	Шаг 4
	Шаг 5
	Шаг 6
	/Шаг 7
	Шаг 8
	Шаг 9
	Шаг 10
	Шаг 11
	Шаг 12

	Методы оптимизации компьютерной графики.
	Методические рекомендации
	Основы компьютерной графики. 2D и 3D графика.
	Графика растровая, векторная и фрактальная, достоинства и недостатки.
	Цвет и модели цвета. Цветовой охват.
	Цифровая цветовая модель RGB. Типографская цветовая модель CMYK.
	Пользовательская цветовая модель HSB и Lab.
	Ручные инструменты выделения и приемы создания выделенных областей. Режимы выделения. Автоматические инструменты выделения. Команды для работы с выделенными областями. Модификация выделенной области. Меню «Выделение».
	Палитра Слои. Перемещение и копирование слоев. Видимость и блокировка слоя. Прозрачность слоя. Фон.
	Редактирование слоев. Группы. Сведение. Создание многослойного изображения.
	Основные приемы рисования. Работа с цветом. История действий. Инструмент заливка. Контуры и узоры.
	Инструмент обводка. Инструмент градиент.
	Кисти. Прозрачность и жесткость кисти. Пользовательские настройки. Создание собственных инструментов рисования.
	Режимы наложения пикселов цвета.
	Приемы и инструменты фотореалистичного раскрашивания и тонирования фотоизображений. Тени, блики, свет. Применение режима «цветность».
	Понятие векторного изображения. Контуры. Операции с фигурами.
	Команды тоновой коррекции: Яркость/Контрастность. Уровни. Кривые. Команды цветовой коррекции: Цветовой баланс. Оттенок/Насыщенность. Замена цвета, выборочная коррекция цвета.
	Автоматическая коррекция. Установка точек вручную. Тени и света. Тонирование фотографий любым оттенком.
	Создание и редактирование корректирующего слоя. Маска отсечения (обтравочная маска). Палитра свойств корректирующего слоя.
	Бернс, С. Фотомагия Photoshop. Трюки и эффекты / С. Бернс. – М.: BHV,  Русская редакция, 2008 . – 448 с.
	Назарова, Ю. Компьютерная графика и Web-дизайн. Практикум по информатике / Ю.Назарова, Т. Немцова. – М.: Форум, 2013. – 288 с.
	Смит, К. Photoshop для цифровой фотографии. Полноцветное издание (+ CD) / К. Смит. – М.: BHV, Русская редакция, 2010. – 448 с.



